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Preface

About This Manual

This manual describes how to use the graphical tool, VSD, to examine the statistics
generated by a GemStone/S 64 Bit or 32-bit GemStone/S repository. This information can
be used for understanding the performance of your system and diagnosing problems, and
for tuning your GemStone configuration. This manual does not describe the underlying
processes, or how to tune your system; that information is specific to the GemStone
product and version, and described in System Administration Guide for your server product
and version.

Terminology Conventions

The term “GemStone” is used to refer to the server products GemStone/S 64 Bit and
GemStone/S, and the GemStone family of products; the GemStone Smalltalk
programming language; and may also be used to refer to the company, now GemTalk
Systems, previously GemStone Systems, Inc. and a division of VMware, Inc.

Technical Support

Support Website
http://gemtalksystems.com/techsupport

GemTalk’s Technical Support website provides a variety of resources to help you use
GemStone products:

» Documentation for released versions of all GemTalk products, in PDF form.
» Product downloads, including past and current versions of GemTalk software.

» Bugnotes, identifying performance issues or error conditions that you may encounter
when using a GemTalk product.

» TechTips, providing information and instructions that are not in the documentation.
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» Compatibility matrices, listing supported platforms for GemTalk product versions.

This material is updated regularly; we recommend checking this site on a regular basis.

Help Requests

You may need to contact Technical Support directly, if your questions are not answered in
the documentation or by other material on the Technical Support site. Technical Support
is available to customers with current support contracts.

Requests for technical assistance may be submitted online, by email, or by telephone. We
recommend you use telephone contact only for more serious requests that require
immediate evaluation, such as a production system down. The support website is the
preferred way to contact Technical Support.

Website: techsupport.gemtalksystems.com

Email: techsupport@gemtalksystems.com

Telephone: (800) 243-4772 or (503) 766-4702

When submitting a request, please include the following information:
» Your name and company name.

» The versions of all related GemTalk products, and of any other related products, such
as client Smalltalk products.

» The operating system, version, and operating system platform you are using.
» A description of the problem or request.
» Exact error message(s) received, if any, including log files if appropriate.

Technical Support is available from 8am to 5pm Pacific Time, Monday through Friday,
excluding GemTalk holidays.

24x7 Emergency Technical Support

GemTalk offers, at an additional charge, 24x7 emergency technical support. This support
entitles customers to get immediate response 24 hours a day, 7 days a week, 365 days a
year, for issues impacting a production system. For more details, contact GemTalk sales.

Training and Consulting

GemTalk Professional Services provide consulting to help you succeed with GemStone
products. Training for GemStone/S is available at your location, and training courses are
offered periodically at our offices in Beaverton, Oregon. Contact GemTalk Professional
Services for more details or to obtain consulting services.
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Chapter

1 VD Overview

VSD (Visual Statistical Display) is a graphical tool that allows you to view and interpret the
statistical information that can be generated by a running GemStone server. GemStone’s
statmonitor utility writes this statistical data to a formatted file, and the VSD utility reads
these files and displays the data graphically, providing a meaningful way to see how your
GemStone system changes over time.

1.1 Statmonitor and VSD

April 2014

Every commercial aircraft in service today contains a flight data recorder, commonly called
a black box. Black boxes are used to help determine what went wrong if the aircraft ever
crashes. Without it, crash investigators would have very little to go on and the cause of
many crashes would never be known.

In a production GemStone application, the statmonitor program serves the role of the black
box. It runs in the background, logging the values of all cache statistics to a text file. Should
a problem with the repository occur, you can review these statistics to determine the cause,
allowing you to identify problems and tune GemStone applications for better performance.

VSD (Visual Statistical Display) allows you to view and interpret the statistical information
that statmonitor gathers. VSD’s graphical user interface gives you a meaningful way to see
how your GemStone system changes over time, based on periodic samples of the system’s
state. VSD reads the statmonitor files and displays the values in a graph. VSD can also start
statmonitor, if it is not already running, and read the values as soon as statmonitor collects
them.

Many questions about repository performance are impossible to answer after the fact
unless statmonitor log files are available. For example:

* Why did markForCollection take longer than normal?
*  Why did the backup run slower than before?

*  Why was there more repository growth than normal?
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*  Which Gem session was consuming the most CPU or I/O during a time of poor
performance?

¢ Which Gem had the most number of commit failures?

If you're trying to answer questions such as these, statmonitor statistics files are your best
source of information. statmonitor reads the statistics from the shared page cache that are
recorded by GemStone processes, and writes those statistics to a file.

statmonitor and VSD are companion tools:

* statmonitor is a stand-alone executable with a command-line interface. This is provided
as a utility with your GemStone server product and version, and is required to be the
same product and version as the shared page cache it will be attached to. It does not
log into GemStone nor use a GemStone session. Statmonitor writes data files to disk, in
a platform- and version- independent text format.

* VSD provides a graphical user interface for viewing the files that statmonitor or GBS
produces. The VSD executable is provided for a variety of platforms. Any version of
VSD running on any platform can load statmonitor data files generated from any other
platform and version of the GemStone server, although some older versions of VSD
may not be able to read statmonitor files produced by recent GemStone server
versions.

VSD with GBS

VSD can also read statistics files generated by recent versions of GemBuilder for Smalltalk
(GBS). For information on how to collect GBS statistics, see the GemBuilder for Smalltalk
User’s Guide, version 7.3 and later. Data files for GBS are generated directly from GBS, not
using statmonitor. GBS statistics files are in binary, rather than text format, and have the
extension .gfs.

GBS's statistics data files can be read by VSD and the data analyzed just as server data is
analyzed. The specific statistics that GBS writes are different than the GemStone server
statistics. These statistics are not included in this manual. The binary format for the GBS
statistics files includes the statistics description information, so you can use VSD to look up
the description of the statistics when viewing GBS statistics.

Running statmonitor

The statmonitor executable is provided as part of the GemStone/S 64 bit or
GemStone/Server, and is described in the System Administration Guide for that version of
the server.

A shared page cache must be running in order to run statmonitor. This may be the Stone’s
shared page cache, if the stone is running on that machine, or a remote shared page cache.

To start statmonitor, at the command line, enter a command similar to:
statmonitor -f outputFile -i samplelnterval stoneOrCacheName

Statmonitor provides a large number of command line options to control monitoring,
including the number and range of processes to monitor and how long to run. These
options are provided in the System Administration Guide for your platform, or you may also
execute statmonitor -h atthe command line.
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Statmonitor can be terminated by CTRL-C, or will shut down when the repository is shut
down.

GemStone recommends running statmonitor at all times for production systems. If the
GemStone system encounters an error, it may be able to report the nature of the error, but
diagnosis of what led to that error often requires understanding previous activity and the
actions of other processes, which can only be understood from statmonitor data.And some
important questions, such as why you ran out of memory or why the repository is out of
disk space, can only be analyzed using data from before the problem occurred.

Statmonitor data files

Statmonitor writes text files to disk, which may be written in compressed form with gzip.

These files contain formatted information, platform- and version- independent, that is read
and displayed in VSD. When VSD monitors a GemStone server directly, it will start
statmonitor and write this file in the current directory.

This file format changes very rarely. The latest version of VSD can always read statmonitor
files generated by older and more recent versions of the GemStone server.

These files normally have the extension .out or .out.gz, although you may specify any file
name.

Statmonitor files written by GemBuilder for Smalltalk (GBS) are written in a binary form,
with the extension .gfs, for GemTalk Flexible Statistics file.

File Size

April 2014

For each sample, statmonitor writes a line for each process being monitored to a data file.
This data file continues to grow as long as statmonitor is running.

With small intervals and a large number of processes, over time this file may become very
large. A longer sampling interval will keep file sizes more reasonable, but may not be fine
enough granularity to catch certain types of problems.

Writing the file in compressed format will save space.

Statmonitor includes options to regularly terminate the statmonitor file and begin a new
one, either by time or by the number of samples collected. For example, you may wish to
start a new file every 24 hours, and delete old files after a few days.

When you are diagnosing specific behaviors, a 1-second sample is the most convenient,
although sub-second intervals may be needed. Monitoring running systems will usually
require a longer interval to keep the file sizes manageable.
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1.2 Installing VSD

10

VSD is provided as part of the server distribution for all versions of GemStone/S and
GemStone/S 64 Bit on all platforms except Windows.

On Windows, the GemStone/S 64 Bit v3.2 and later distributions for Windows include
VSD. For earlier versions of GemStone/S 64 bit and for GemStone/S, VSD is provided as
a separate add-on, downloadable from the technical support website.

If you will be running VSD on a machine other than the one in which the GemStone server
is installed, you can download the appropriate platform of VSD and install it on that
machine.

Although the GemStone/S 64 Bit server does not support Windows, you can view
statmonitor files generated by GemStone/S 64 Bit using VSD on Windows.

On UNIX platforms, VSD requires X-Windows.

Installation on all platforms

Installation is simple. The following instructions use / as a path separator, although the
process is the same on Windows.

1. Download the VSD distribution, and unzip it into your VSD installation directory,
vsdInstallDir.

This will create two subdirectories in vsdInstallDir; vsdInstallDir /bin, which contains
the VSD executable files, and vsdInstallDir/lib, which contains several subdirectory
trees containing the VSD library files.

2. Itis convenient, but not required, to add vsdInstallDir/bin to the machine search path.

If the bin directory is not added to the machine search path, you may execute vsd
directly from vsdInstallDir. VSD will search for the library files under the /lib
subdirectory of the executable’s parent directory, so you do not need to add this
directory to the path.
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) VD's Graphical Interface

VSD provides a graphical way to view the data that is recorded by statmonitor. When you
open VSD on this data, you will see a very large number of statistics that were recorded for
potentially a very large number of GemStone processes. Not all of these are going to be
useful; your task is to locate the interesting and useful information.

2.1 Starting VSD

You can start VSD from your windowing system or from the command line.

* Double click on vsd in a graphical file browser
or vsd. exe in Windows Explorer.

* Execute vsd at the command line.
You can either provide the full path to the vsd executable, navigate to the directory
containing vsd, or, if the directory containing the vsd executable is on your machine
search path, just enter ‘vsd’.

You may start VSD and automatically open a specific data file by:
* execute vsd, specifying the statistics file name on the command line.
For example:
prompt> vsd statmonDataFileName
vsdinstalldir/bin/vsd statmonDataFileName

* On windows, you drag a statmonitor data file and drop it on vsd.exe in Windows
Explorer

The main VSD window will appear; if this is your first time running VSD, an additional
window will appear providing access to the version history and help.
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2.2 Main VSD Window

When VSD is started, it displays the Main window. This window has a single instance and
remains open while you are running VSD.

The main window displays the list of processes and other information about the
statmonitor file; here, you will locate and select processes and statistics for which you want

to view charts.

This window also contains many configuration options that control how your charts are
displayed. These options are stored, so next time you open VSD you will get the same
options. For more details, see “VSD Configuration Files” on page 30.

Hain Eile Chart Template Help

File:| +
StartTime | File | Samples | ProcessId | Sessionld | Type| Hame

_h

Chart: | 3
| New Chart |

Loading data for viewing

12

If you opened VSD with a particular data file or files as an argument, the main window will
display the processes listed from that file. Otherwise, you need to load a data file, or start
monitoring a running server.

GemTalk Systems
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Loading an existing statmonitor file

To load a statmonitor file into VSD, use the menu item Main > Load Data File...

This brings up a file dialog that allows you to browse for an existing statmonitor output
file.

If you know the name of the file you would like to load, you can also type the full path in
the File entry box.

Updating the view if the data file is updated

You may load a statmonitor data file that is still being updated by the live system. As new
data is added to this file, you have the option to have vsd update its view.

If you select File > Auto Update, VSD automatically updates your display, and any
associated charts, any time the data file changes. Otherwise, if auto update is disabled, you
can choose File > Update periodically to update the displays when you choose.

Loading multiple data files

You can load multiple statmonitor files using the menu item Main > Load Data File...., or
by specifying multiple files on the command line. Each file is loaded, though you can view
the list of processes for only one file at a time. To switch between them, click the down-
arrow next to the File entry box, then select a file from the list.

If your multiple data files are logically a single data set; (for example, you start statmonitor
on the same repository, shut it down, and start it again), then you can append the second
data file rather than load it. This is done using the File > Append Data File menu item, or by
using the -a command line argument.

Monitoring statistics on a running GemStone server

April 2014

You can use VSD to start statmonitor and automatically read directly from the data file
statmon is currently creating. This options is not available on Windows.

To monitor a live system:

Step 1. Bring up the Monitor window using the menu item Main > Monitor

2 & @ Monitor
Cache Hawe | StatHon | Version | Creator
nshdstone™4dbhe72855765fel <none> 3.2.0 lalmarod
nione <none > 2.6,32-50-generic benton.,gentalksystens .com

StatHon Output:
Sample Interval: |2 jllr'ite Interval: |2 jLevel: 4 jﬂppﬂtat Count: |5 j
_I Compress Pids: Sessions:

Refresh | Start | | | Dismiss |

The Monitor window will display a list of anything that statmonitor can monitor on
this host; all shared caches on this machine, and the system itself.
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14

Step 2. Select the cache you wish to monitor, and the monitoring options.

These options are a subset of those offered by the server statmonitor utility. Options
are:

* The file name for the statmonitor output.

By default, this is empty, and statmonitor will create a file with the default name
in the current directory. You must have write permission for the directory in which
this file is located. For example, if you started vsd while in the $GEMSTONE/bin
directory, you must specify a path and filename for another directory, in which
you do have write permission.

* The sample interval (in seconds) — that is, how frequently to read the cache.

* The write interval — the maximum number of seconds to wait before flushing the
samples to the output file. This determines the rate your monitoring view is
updated.

¢ The statistics level — the amount of non-GemStone, OS-level information to collect.
Larger numbers result in more level of information being sampled. Available
levels vary by platform.

* The number of application statistics (shared counters) to gather.
*  Whether to compress the output file.

* You can select to monitor only processes with specific Process Ids or Session Ids.
Normally, all processes are monitored.

Step 3. Click the Start button to start monitoring.

This will start statmonitor, and create a statmonitor data file in the current working
directory. If statmonitor startup fails, the Monitor status window will appear which
shows the statmonitor command line.

The Monitor windows will remain open. You can use the Dismiss button to close the
window; this does not affect monitoring.

VSD loads the data file as soon as it has some samples in it (unless you have explicitly
turned off Auto Update).

The statmonitor data file that is created by monitoring will grow as long as you are
monitoring. If you have a large system and collect samples frequently, this file may
become very large.

Step 4. Click the Stop button to stop monitoring.

If you have dismissed the Monitor window, you can re-open it using the menu item
Main > Monitor. Select the cache you have been monitoring to enable the Stop button.

Note that the statistics data that is created will remain, and can be viewed later. It must
be explicitly deleted if you no longer need it.
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After you've loaded the data file or started monitoring, the VSD window looks something

like this:
Hain File Chart Tewplate Help
File: ELinux 2.6,32-50-generic #112-Ubuntu SMP Tue Jul 9 20:28:23 UTC 2013) 3.2.0 ﬂ
Startline | Fi Iel Samples | ProcessId | Sessionld | Type | Hame | £
03/04 18:19:07 1 153 13925 1 Sth pagengrThread
03/04 18:19:07 1 158 13925 5tn gshidstone
03/04 18:19:07 1 158 31495 Statmon StatHon
03/04 18:19:07 1 158 13927 Shrpc  EhrPcHonitor
03/04 15:19:07 1 158 13042 Pesvr  FreeFruPgsyr2
03704 18:19:07 1 158 13946 Pesvr  RioPgsvrl
03704 18:19:07 1 158 31493 7 Gemn Topazll
03/04 18:19:07 1 158 31484 =] Gen Topazl10
03/04 18:19:07 1 158 28003 5 Gen Topaz9
03/04 18:19:07 1 158 13969 5 Gen Symbo | Gent
03/04 18:19:07 1 158 13965 2 Gen GoReclainG —
03/04 18:19:07 1 158 13967 4 Gen GeAdwin® 7
=k
AbortCount :
AbortInProgress
AfterLogoutState
AioCkptCount
AiolirtyCount
AiolumBuffers 7
Chart: | 3
I Hew Chart |

Process List

The upper list pane contains a list of all the entities — processes, thread-based sessions
within processes, and other entities such as the disks —for which data is recorded in the
statmonitor data. Depending on the options used to collect the data, this may include all
GemStone processes or a small subset, and may include a number of non-GemStone
entities including the operating system, disks, etc. While these are not all strictly
“processes”, in the following discussion this term is used to include all entities that appear
in the process list.

For each process, session, or other entity, the display includes:

* The StartTime - the time that process first recorded a sample, adjusted to local time on
the machine executing VSD.
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Sorting

* TheFileid for the file in which it was recorded. This is of interest if you have more than
one file loaded; the file id corresponds to the number in the file select drop-down.

* The total number of Samples for that process recorded in the data file.

If you are monitoring, processes that are currently running and for which samples are
being taken are shown in green, and these number will change as new data samples
are taken.

* the OS ProcessID for the process. Multi-threaded processes in which the threads are
GemStone sessions will have individual entries for each thread, and list the same
process 1d for each.

* the GemStone Sessionld for that processes. This only applies for GemStone session

* the Type of the process. GemStone processes fall into a number of types, which govern
which statistics apply. The common process types are:

Stn Stone

Shrpc shared page cache monitor

Pgsvr AIO or free frame page server, or a page server for a remote session

Gem Gem; includes system Gems, RPC Gems, and linked sessions such as
linked Topaz

Statmon statmonitor

Additional types will appear if you are also monitoring OS information, including
platform-specific statistics.

* the process Name. This is assigned by the GemStone and vsd. It may be controlled for
Gem processes; see “Process names in GemStone” on page 25.

By selecting a column header in the main windows, you can sort all the processes by that
column’s attribute.

For example, if you want to find the Stone, you can sort by Type. Or, if you know the
session ID of the Gem, you can sort by Sessionld and scroll down under you find that Gem.

Selecting Process

16

When you select a process, the list of statistics relevant for that process is displayed in the
statistics pane. Multiple selection is allowed.

Selecting Sets of Processes

The pop-up menu option Select allows you to select all processes matching a particular
criteria. The options are:

All —select all processes

By type —select all processes of the same type as the currently selected process. Does
nothing if no process is selected.

By statistic —select all processes for which the currently selected statistics
applies. Does nothing if no statistic is selected.

Clear —deselect all
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Statistics List

The lower pane displays a list of statistics.

Each process type has a specific set of statistics that are relevant for that process. Many of
these are unique for that process type; for example, CommitCount applies to Gem
processes, while TotalCommits is meaningful for the Stone. Others, such as UserTime,
apply to all processes.

When no processes is selected, all statistics in the system are shown. When a particular
process is selected, only statistics appropriate for that process type are listed. When
multiple processes are selected, only statistics that are common to all the selected process
types will be listed.

You may scroll down the list to locate the statistic you want. Typing in the first character
will select the first statistic with a name beginning with that letter.

Notice that some statistics are listed in bold font, while others are in regular font. Statistics
with the font in bold have non-zero values recorded.

Controlling visibility of statistics

April 2014

Hiding statistics with only values of zero

You may hide statistics for which the value of that statistic is 0 for the entire sample set.
These are the statistics that are listed in non-bold font.

To hide statistics where there are no non-zero values, check No Flatlines in the Main menu
or in the right mouse button popup menu.
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Statistics Level

Each statistic has a characteristic called a level reflecting the amount of background
knowledge about GemStone processes needed to use it with understanding. You can set up
VSD to list only those statistics that are at, or below, a certain level of complexity.

To establish the levels of statistics that you want to display in VSD, choose Statistic Level
from the VSD window’s Main menu:

Load Data File...
Honitor. .. Ctrlin
Change Directory...
Change Time O0ffset...
Copy Selection Cirl+c
[~ Zhow Statistic Info
" Combine
" Combine Across Files
" Ho Flatlines
" %ingle File Hode
[ Absolute TimeZtamps
" Copy Referenced Lines

Statistic Level " ~ Common Statistics Only

“~ Advanced & Common Statistics
“All Statistics

[ Confirm Exit

Exit

The level of statistics you select will be recorded in your . vsdrc file, and will be used
automatically the next time you start VSD. See page 30 for details on VSD configuration
files.

Meaning of statistics

18

While many statistics have intuitive names, you will often need to look up details.
Chapter 4, starting on page 11, as a complete list of statistics.

You should not expect to understand every statistic recorded for your system. Some of
these statistics require an intimate knowledge of GemStone server internals, some are
experimental, some may only apply under specific server conditions. GemStone
documentation, Techtips, and analysis from GemStone Technical Support will include
specific statistics that are particularly helpful.
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The information in the current version of VSD, including more detail, is displayed in the
Statistics Information Window. To open the Statistic Information, use the menu item Main
> Show Statistics Info.

& @ @ sStatistic Information

|T|:|talI3|:|mmit3 | ﬂ

Kind: |counter Units: EEEEEEQ
Types: @

Default Filter Default -ﬂl

Level: common = |

Statistic Help |

—Statistic Description
The total number of commits,

excluding read-only commits, o
performed by all sessions since the
/

stone was last started.

This singleton window can be left open; it will display the details for any selected statistics
as it is selected. You can also lookup statistics using the drop down.
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Selecting and viewing statistics

After you have selected one or more processes and one or more statistics, you can display
these results in a chart by clicking on the New Chart button. You can create a named chart
by entering a name in the Chart name entry field.

If you have a chart open, you can add the selected statistics to an existing chart. Select the
chart by name in the drop-down with the Chart name entry field, then click on the Add
Line button. The Chart name is set to the most recently selected chart, so if you do not
explicitly select a chart, the statistics will be displayed in the most recently selected chart.

The following shows the main window with one process selected, the Stone, and two
statistics selected, TotalAborts and TotalCommits.

Hain File Chart Tewmplate Help

File: §Lir'|u>< 2.6,32-50-generic #112-Ubumtu SMP Tue Jul 9 20:28:23 UTC 2013) 3.2.0 ﬂ

StartTine | File | Samples | ProcessId | Sessionld “@ | Hawme | —
03/04 18:19:07 1 158 13925 1 Sth pagengrThread
023704 18:19:07 1 158 13925 Stn gshdstone
03704 18:19:07 1 158 31498 Statmon StatHon
03704 18:19:07 1 158 13927 Shrpc ShrPcHoni tor
03/04 18:19:07 1 158 13942 Pgzvr  FreeFrmPesyr2?
03704 18:19:07 1 158 13946 Pzzvr  RioPgsvyr3
03/04 18:19:07 1 158 31493 7 Gemn Topazil
03704 18:19:07 1 158 31434 6 Gemn TopaziD
03704 18:19:07 1 158 25003 5 Gen Topazd
03504 18:19:07 1 158 13969 & Gen Symbo|Gent
03704 18:19:07 1 158 13965 2 Gen GeReclaind L—
03504 18:19:07 1 158 13967 4 Gen GeAdminT 7
L R R L B il —— =
TimerThreadWakeups i
TimeMaitingForIo
TotalAborts
TotalCommits
TotalbGenFatalbrrors _‘,-"'
Chart: | ﬂ

Add Line I Hew Chart |
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2.3 VSD Statistics Chart

VSD statistics charts allow you to view and analyze the data for the statistics you have
selected. You may have many charts open.

Chart Window

When you first open a chart, all the values for all statistics are displayed with its default
settings. Each line has a unique color and/or pattern.

Chart : w (] vl |—J : —|J|—:,'

12 —

in —

Left Axis

[ U [ U [ J I
20515540 20219300 20z19:20 20319240
Tine HAxiz

l—i. asbtstone, TotalRbortsdsec 2+ asbitstone, TotalCommitsdsec

At the bottom is the Legend - the list of process statistics that are viewed in this chart. Each
is described by Process name and statistics name.

The axis of the graph are labeled; the bottom axis is always time.

The Y-axis is labeled with the number of the units for all the statistics; this may or may not
be meaningful, if the statistics used different units of measurement. For example,
comparing the counts of the number of commits and the time waiting for I/O, by units,
does not directly make sense. However, it can be very useful to see how each varies relative
to the other over time.

Chart Options

You can customize and manipulate a VSD chart in many ways to make your analysis
easier. A few of the more useful are described here. The VSD application includes help for
each menu item.
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Zoom

To zoom in on a subsection of the chart, use the menu item Chart > Zoom In. This prompts
for a rectangle to zoom in to, allowing you to view with more detail the section of the chart
that you are interested in. You can zoom in multiple times to narrow your view further.

Zoom Out returns you to the previous level of zoom.

Time Format

The times marked on the Y axis, by default are in HH:MM:SS format (with hours in 24-hour
format). If your sample spans multiple days, you can set the time format to include the
month and day using the Chart > Time Format menu item.

Selecting a Line

22

You can select an individual line from the Legend at the bottom, or by clicking on that line
in the graph. Selecting a line colors it red and displays information about that line.

Chart Line wa ] vl I—ﬂ Pertecand _| ﬂ:gm g

di—

pointz: 75 mind 2,0 max: S,0 mean: 4,77333 =41 1,18062

1 —

Commits / zecond
1
i —p——

: [ : [ : I
20215540 20219200 20219220 20219240
G, statmonld403 xG6_64 3,2,0

I—l, asbdztone, TotalAbortz A zec 24 azbdstone, TotulComn:itsz‘secI

When a line is selected, the following information is available:

* On the graph itself, a brief summary statistics for the line. This includes the number of
data points for that statistic, the minimum, maximum, and standard deviation are
displayed. These units stay the same regardless of scale or transformation.

*  When the mouse is over a data point in the graph, the X (time) and Y (units) of that
point are displayed. These units stay the same regardless of scale or transformation.

¢ the name of the statistic.
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* the current filter. The filter allows you to distinguish absolute values from rates of
change. Each statistic has a default filter, which can be changed as needed.

* The scale or other transformation. The scale allows you to compare lines with widely
different ranges of values, by scaling one or the other to bring the ranges closer
together.

Changing Line Options

April 2014

Filters

The filter allows you to view either absolute values, rates of change per second or sample.
Filter options are:

None — Displays the values for the statistic exactly as they are expressed in the
statmonitor text file.

PerSample — Displays the difference between two consecutive samples of the
statistic.

PerSecond — Displays the difference between two consecutive samples of the
statistic, divided by the number of elapsed seconds between the two samples.

Aggregate — Displays a running total for the per-sample deltas of the statistic.

Scaling

When you have multiple lines with widely different ranges of values, you can increase the
visibility of a line relative to the other line by scaling it.

Select the line, and in the upper right, use the arrow indicators to scale up or down the line.

Other Transformations

By default, S is selected for the transformation setting, between the filter list and the scaling
value entry field. When S is selected, the numeric scrolling field is used to scale the selected
line.

You may also select other options, rather than S. This allows you to transform the line by
adding, subtracting, multiplying, or dividing the value in the numeric scrolling field.
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Summary of Information on a line

The menu item Line > Log Info will open (or append to an already open log window),
summary information about a single line. For example:

2 & @ VvsdData Log

Line: {gstdstone 13925 0} TotalCommits filter: persecond
Starting at 20:18:35 and ending at 20:19:49:
sample count: ¥9 min: 2.0 max: 8.0
average: 4.77333333333 stddev: 1.18062435765

<l |+

Fl | [

Summary of Information on a section of line

A very useful tool is collecting statistics on a section of line. For example, you may want to
know the commit rate over a single period of intense activity, rather than for the entire
period of sampling.

The menu item Line > Log Delta will allow you to select two point on the selected line. It
then opens (or appends to an already open log window), summary information about that
section of line.

5 @& Vvsd Data Log

Delta on f{gsBdstone 13925 0} TotalAborts [
pointl: 18:20:16, ©
pointZ: 18:21:38, 3
time delta = 1 minute, 22 seconds.
value delta = 3 Aborts / second.
valuestime delta = 0_.0365853658537 Aborts / second per
OFf the 83 data points in this range:
the min is: 0.0
the max is: 7.0
the averape is: 3.18072289157 _
the stddev is: 1.30799211523
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Other ways to control the view

There are many ways to control what you are viewing to make analysis of your data easier.
Here are a few that are particularly useful.

Combining statistics values for multiple processes

Normally, when opening a chart or adding lines to an existing chart, one line is added for
each selected process for each selected statistic. If you have selected a large number of
processes — for example, all Gems — this may be cumbersome to see in the resulting chart.

In cases like this, you can combine values for a single statistic for all the selected processes.
To combine values, check the value Combine in the Main menu or in the right mouse
button popup menu.

Process names in GemStone

When statmonitor records statistics for Gem processes, it records them with the name
“Gem”, or for linked topaz logins, “Topaz”. This can be modified on the GemStone server
after the gem logs in. This can be particularly useful for regular maintenance processes,
such as your backup or markForCollection, that are run from scripts.

To do so, as soon possible after login, in the session you want to rename, execute:
System cacheName: 'myName'

Depending on how soon you can execute this after login and the statmonitor sample rate,
you may have one or more samples showing the original default name.

Changing Hours Offset

Timestamps are recorded in statmonitor data files using GMT time. When these files are
read into GemStone, VSd will translate these times into the current machine’s local time.

If you are viewing the data in VSD in the same time zone as the system that generated the
statmonitor data, this means that VSD will display dates in the correct time, including
adjusting for daylight savings time.

However, if you are viewing statistics in a different time zone, the timestamps will appear
to be incorrect.

To correct this, use the main menu option Change Time Offset..., and select the number
of hours plus or minus to adjust VSD’s display.

For example, if you are in U.S. Pacific Time and viewing statistics that were generated by
a system running in U.S. Eastern Time, which is three hours ahead, add three hours:

@ @ change Time Offset

‘ M Cancel |
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2.4 Using and Creating Templates

VSD templates let you quickly create a chart with a commonly used set of statistics.
Templates are helpful if you find yourself performing the same task frequently in VSD —
for example, monitoring the same five or six statistics. By creating a template for the
statistics that you want to monitor most frequently, you can automate the task of building
charts.

VSD is shipped with a set of predefined templates. You can open charts on these templates
using Template > New Template Chart, and choosing any of the predefined templates. If
you create your own custom templates, they will also appear in this list.

You can create a custom template based on a chart you have created in VSD, or by editing
the formatted text file that contains the templates. See “VSD Chart Templates” on page 27
for more on the text file and how it is formatted, and editing this file outside of the GUI.

To create a custom template from VSD:

Step 1. set up a chart with the processes, statistics, scaling, and so on, that you want in
your template.

Step 2. Chose the Chart menu item Save Template. This will prompt you to enter a name
for the custom template. Hit the enter key when you are done.

You can now use your new template, from the Template > New Template Chart menu
item.

if you want to remove your template, edit the .vsdtemplates file, and use the menu item
Chart > Reload Template File to reload the templates file.

Gem and Pageserver Names in Templates

When you create a template that includes processes that are Gems or PageServers, the
name of the process, as well as the type, is included in the template. This helps avoid an
excessive number of lines appearing when the chart is opened.

The name that is included does not include any serial numbers that are displayed with the
name in VSD. So for example, if the chart on which you are creating a template includes a
Gem named Topaz19, the template will use Topaz* as the name. When you later use the
template to create a chart, lines will be added for all Gems with the name Topaz.

Since you may have many Topaz processes, and cannot determine which one is performing
a particular task such as backup or MFC, including Gem and Page server statistics in
templates requires more consideration. Providing the Gem with a name, as described
under “Process names in GemStone” on page 25, is one solution.

26 GemTalk Systems April 2014



Chapter

3 VD Template and

configuration files

The first time you use VSD, the executable creates default template files and configuration
files in your home directory. These files are used on subsequent executions; this allows it
to remember the statistic level you have selected, window sizes and locations, and similar
details.

You can delete these file at any point, and they will be recreated from the default the next
time you use VSD.

3.1 VSD Chart Templates

VSD templates specify a set of processes and statistics that together represent a useful
picture of one behavior of the system. VSD is shipped with a set of predefined templates.
As described in “Using and Creating Templates” on page 26, you can open charts on these
templates, and create your own templates based on charts you have constructed.

To further customize the templates you use, you may want to edit the templates directly.
The templates are stored in a text file using specific syntax. This section provides
information you need if you wish to edit the template files directly.

VSD Templates File

The default templates are in the file .vsdtemplate, which is written to your home directory
the first time you start up VSD.

If you delete the . vsdconfig file, then the next time VSD is started, the file will be
recreated with default values.

Template Syntax

April 2014

The template files are written in a formatted form that is understood by the TCL code that
supports VSD.
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Templates in the .vsdtemplate have the following form:

set vsdtemplates (TemplateName) {
{Type {ProcessName} StatName scale filter axis}
{Type {ProcessName} StatName scale filter axis}

for example:

set vsdtemplates (Garbage) ({
{stn {*} PagesNeedReclaimSize 1 none y2}

{stn {*} ReclaimedPagesCount 1 none y2}
{stn {*} EpochGcCount 1 persecond vy}
{stn {*} ReclaimCount 1 persecond vy}
{Gem+ {*Gc*} CommitCount 1 persecond y}

}

set vsdtemplates (CacheTooSmall)
{Shrpc ShrPcMonitor FreeFrameCount 1 none y2}
{+ {*} FramesFromFreeList 1 persecond vy}
{+ {*} FramesFromFindFree 1 persecond vy}

}

The data for each line in each template includes:
type — One of the following;:

Stn
Shrpc
Gem
Pgsvr

‘+’ can also be used, which means that all processes that match this line spec will be
combined into a single line. + can be used either standalone, meaning all process types,
or added to a type name. For details on types, see page 16.

name — Identifies the specific process by process name. You m.ay use * to match multiple
process names. For more on process names, see page 16.

stat — The name of a specific existing statistic.

scale — The number of the scale for this particular statistic. It will usually be 1. For more
details on scales, see”Scaling” on page 23.

filter — The name of the filter, which will be one of the following;:

none

persecond
persample
aggregate

For details on these filters, seeFilters” on page 23

axis — Either y, the left axis, or y2, the right access. Units for this statistic line are labeled
on the specified side y-axis.
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Once you have created or edited your template file, save the .vsdtemplates file, and use the
menu item Chart > Reload Template File to load this file. If you have made syntax errors,
this file will not load.

For more about VSD templates and the syntax and options available, see the VSD help
under the topic “Template Syntax”.
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3.2 VSD Configuration Files

.vsdrc

VSD provides a number of configuration options, which are set by menu items in vsd.
These options are recorded in platform-independent text configuration files in your home
directory.

There are two configuration files that together manage the configuration parameters that
control what you see on startup.

This file is used by VSD to record its current configuration. VSD reads the file when it starts
and writes the file when it exits.

If you delete the . vsdrc file, VSD will start with defaults from .vsdconfig or from the VSD
executable. When it subsequently exists, the file will be recreated with the current settings.

You should not modify this file manually. To make changes in the way that VSD is always
started, no matter how it was configured at the previous shutdown, edit the .vsdconfig file.

.vsdconfig

You can configure VSD by setting default values in this file. Any value setin . vsdconfig
will override the same definition in . vsdrec.

If you delete the . vsdconfig file, then the next time VSD is started, the file will be
recreated with default values.

Configuration file format

30

In most cases, you can configure your default display using by taking advantage of the
natural way VSD saves your settings to . vsdrc and reads them on restart. By doing this,
you get a consistent display without any extra work.

However, if you want to set a configuration that is always used, regardless of what you do
during any particular VSD session, you will need to edit the VSD configuration

file . vsdconfig. The configuration file format is the same in . vsdconfigand .vsdrc,
so you may copy lines between files.

The following sections document many of the relevant configuration parameter names and
meanings.

Configuration options are specified in a format that is specific to VSD/TCL, and are not
intended for general use by customers.

To include a comment line, prefix the line with #.

Incorrect configuration names and settings encountered in reading the files are ignored;
default values will be used in this case.

Configuration options have the format:
set vsd (configurationOption) value
for example:

set vsd(confirmonexit) 1
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Acceptable value arguments depend on the parameter. Many are Integers, but some
parameters are strings. Lists are indicated by {}. Boolean statistics are specified as 0 or 1.

Main Window options

The following statistics relate to the main VSD window.

Parameter name Type | Default Description
confirmonexit Boolean | 1 Whether to confirm before
(Oor1) exiting VSD, Main > Confirm
Exit
def :sortbytype Column | Type On file load, the column to use to
label sort processes.
def :sortdecreasing Boolean | 1 On file load, the direction of sort
(Oor1) for the process list; 0 is
decreasing, 1 is increasing.
combineFiles Boolean | 0 Whether to combine values for
(Oor1) all selected processes in all open

files when displaying a statistic;
Main > Combine Across Files

combinelnstances Boolean | 0 Whether to combine values for
(Oor1) all selected processes when
displaying a statistic; Main >
Combine
filelist list of empty | List of filenames displayed in the
strings | list Main Window File: dropdown.
noFlatlines Boolean | 0 Whether to show statistics for a
(Oor1) process if all values for that
statistic are zero; Main > No
Flatlines
showCtrInfo Boolean | 0 Whether to have the Statistics
(Oor1) Information window open. Main
> Show Statistics Info
singleFileMode Boolean | 1 Whether working with multiple
(Oor1) data files is allowed. Main >
Single File Mode
templatesUseSelection | Boolean | 0 Whether the template applies
(Oor1) only to the selected processes.
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Chart Window Display Options

32

The following parameters describe the defaults for including and omitting information
from chart windows.

Parameter name Type Default Description
absoluteTSMode Boolean 1 Whether to use absolute
(Oor1) timestamps for charts. Main >
Absolute Timestamps
activecolor string red The color of the selected line on a
chart. Chart > Selected Line
Color...
def:linestyle linear | linear How the line is rendered on
step | charts; Chart > Default Line
natural | Style
quadratic
def :showcrosshairs Boolean 0 Whether to show cursor
(Oor1) crosshairs on charts, Chart >
Show CrossHairs
def : showcurxy Boolean 1 Whether to show current X and Y
(Oor1) values on a chart; Chart > Show
Current Values
def:showgridlines Boolean | 0 Whether to show gridlines on
(Oor1) charts, Chart > Show Grid Lines
def : showlegend Boolean |1 Whether to show the legend (the
(Oor1) process and statistic name and
line color for the chart lines) on
charts; Chart > Show Legend
def :showlinestats Boolean | 1 Whether to show text with points,
(Oor1) min, max, mean, and standard
deviation on graph; Chart >
Show Line Stats
def : showminmax Boolean 0 Whether to show max and min
(Oor1) values on chart menu bar; Chart >
Show Max and Min
def :xaxis:showtitle | Boolean |1 Whether to display label on x axis,
(Oor1) Chart > Show Time Axis Title
def :xformat date | time How to display the time on the x-
time | axis of a chart; Chart > Time
elapsed Format
def:yaxis:showtitle | Boolean |1 Whether to display y axis label on
(Oor1) left side, Chart > Show Left Axis
Title
def:y2axis:showtitle | Boolean |1 Whether to display y axis label on
(Oor1) right side, Chart > Show Right

Axis Title
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Monitor Window Options

The following parameters apply to the Monitor window, describing options for how to
start statmonitor.

Parameter name Type Default Description
wv:statmoninterval integer 20 Monitor window, default
statmonitor sample interval
wv:statmonflush integer 0 Monitor window, number, default
statmonitor flush interval
wv:statmonlevel integer 1 Monitor window, number, default
statmonitor statistics level
wv:statmonappstats integer 0 Monitor window, number, default
statmonitor number of app stats
wv:statmonsessions | list of empty | Monitor window, default for list of
integers | list session ids to monitor in statmon
wv:statmonpids list of empty | Monitor window, default for list of
integers list process ids to monitor in statmon
wv:statmoncompress Boolean 0 Monitor window, default for if
(Oor1) statmonitor should write

compressed file

Window locations and display

Fonts

April 2014

The location, size, and proportion of the Main Window, the Chart window, and the Statics
info file are recorded.

def : geometry sets the size and location of the main window.
instancePanesSize sets the height of the Process pane in the main window.
statisticPaneSize sets the height of the Statistics pane in the main window.
geometry: .datawin sets the size and location of the chart window.

geometry: .ctrinfo sets the location of the statistics information window.

Window title, menu, and other fonts are based on operating system default fonts, and are
not controllable. However, you may set the font for text panes and for charts.

Main window text fonts

textfont is a list of font attributes that controls what is used to display text on a chart
windows. This configuration is used for most text on a chart: legend, axis labels, summary
information, etc. Attributes include the font family, size, weight, slant, underline and
overstrike are options. These can be set using Help > Choose Text Font.... For example,

textfont {-family fixed -size 10 -weight normal -slant roman -
underline 0 -overstrike 0}
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Chart window text fonts

smallfont is a list of font attributes that controls what is used to display text on a chart
windows. This configuration is used for most text on a chart: legend, axis labels, summary
information, etc. Attributes include the font family, size, weight, slant, underline and

overstrike are options. These can be set using Chart > Choose Chart Font.... For example,

smallfont {-family fixed -size 12 -weight normal -slant roman -
underline 0 -overstrike 0}
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This section lists GemStone statistics in alphabetical order. The heading indicates the
processes for which the statistic is applicable: Stone, Gem, SPC monitor (shared page cache
monitor), Pgsvr (AIO, Free frame, or remote gem page server), or all.

AbortCount (Gem)

The number of aborts executed by a Gem process (or by an application linked to a Gem)
since the Gem was most recently started.

AbortinProgress (Gem)

A boolean that indicates if the session is currently performing an abort operation.

AfterLogoutState (Stone)

Bits from the after-logout state machine in stone.

AioCkptCount (Pgsvr)

The number of dirty pages written from the shared page cache to disk to satisfy a
checkpoint.

AioDirtyCount (Pgsvr)

The number of dirty pages written from the shared page cache to disk by Stone’s AIO page
server during normal operation.

AioNumBuffers (Stone)
The current setting of the STN_MAX_AIO_REQUESTS configuration parameter.

AioNumEmptyBuffers (Stone)

The number of internal AIO buffers that are currently empty. The stone will block when
starting a tranlog write unless at least 3 buffers are empty.
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AioRateLimit (Pgsvr)

The current I/ O rate being used by the page server, expressed in I/ O operations per
second. The page server will perform no more than this number of I/O operations per
second on average.

AioRateMax (Pgsvr)

The current maximum I/ O rate being used by the page server, expressed in I/O operations
per second. The page server will perform no more than this number of I/O operations per
second on average.

AioWriteFailures (Pgsvr)

Total number of write errors detected by this page server, including write errors that
succeeded on retry.

AsyncFlushesinProgress (Pgsvr)

The number of pending extent flush operations.

BackupHighWaterPage (Stone)

The lowest page ID for which the GC reclaim gems will temporarily ignore because a full
backup is in progress. Pages with IDs less than this value will be reclaimed normally. Page
IDs equal to or greater than this value will not be reclaimed. The session performing the
full backup will increase this value as the full backup progresses.

BackupRecordPagesWrittenByGem (SPC monitor)
BackupRecordPagesWrittenByStone (SPC monitor)

The number of backup record pages in the cache because of a write done by a Gem or by
the Stone, respectively.

BitlistPagesWrittenByGem (SPC monitor)
BitlistPagesWrittenByStone (SPC monitor)

The number of bitlist pages in the cache because of a write done by a Gem or by the Stone,
respectively. A bitlist page is a form of a bit array.

BitmapPageReads (all)

The number of bitmap pages read by the process since it was last started. These page reads
are actual disk reads and not reads from the shared page cache.

BmCHeapPages (Gem, Stone)

The number of temporary bitmap pages allocated on the C heap of the process.

BminternalPagesWrittenByGem (SPC monitor)
BminternalPagesWrittenByStone (SPC monitor)

The number of bitmap internal pages in the cache because of a write done by a Gem or by
the Stone, respectively.
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BmLeafPagesWrittenByGem (SPC monitor)
BmLeafPagesWrittenByStone (SPC monitor)

The number of bitmap leaf pages in the cache because of a write done by a Gem or by the
Stone, respectively.

CacheScanCount

Number of times the shared page cache monitor statistics thread has scanned the entire
shared page cache.

CacheSlotindex (all)
Index of the slot in the shared page cache used by this process.

CacheStartQueueSize (Stone)

The number of sessions waiting for remote cache startup.

CHeapSizeKB (all)

The size (in KB) of the C heap area; that is, the total size of results of UtIMalloc for which
UtlFree has not been called. This statistic is computed only in slow or fastdebug
executables.

CheckpointCount (Stone)

The number of checkpoints that have been written since the Stone repository monitor was
last started. Writing a checkpoint implies that all of the data and meta information needed
to recover the data corresponding to the commit record associated with the checkpoint
have been written to the disk(s) containing the extent(s) that make up the repository. Thus,
the last checkpoint in the transaction log determines how much data in the log must be
recovered when there is a system crash.

In full logging mode, the checkpoints are controlled completely by the
STN_CHECKPOINT_INTERVAL configuration parameter. In partial logging mode, a
checkpoint may be written more often if the size of the transaction exceeds the value set by
the configuration parameter STN_TRAN_LOG_LIMIT. If partial logging is in use, a rapidly
increasing CheckpointCount indicates that STN_TRAN_LOG_LIMIT may be set too small.

CheckpointState (Stone)
This internal statistic indicates the state of the checkpoint process:

0 — checkpoint not active

1 — AIO servers writing pages

2 — pre-fsync processing

3 — synchronous fsync

4 — asynchronous fsync

5 — second fsync

6 — dispose alloc pages shadowed
7 — write log record

These values are provided for information only and are subject to change without notice.
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ClassesRead (Gem)

The number of classes copied into VM memory since the start of session.

CleanSlotsinRecoveryCount (SPC monitor)

The current number of slots being recovered which were owned by a process which
shutdown cleanly.

CleanSlotsRecoveredCount (SPC monitor)

The total number of slots the shared cache monitor has recovered because a client process
shutdown cleanly.

CleanSlotThreadTimeRunningMs (SPC monitor)

Approximate real time in milliseconds that the clean slot recovery thread in the shared
page cache monitor has spent doing work.

ClientAbortinProgress (Pgsvr)

A boolean indicating if the page server's client Gem is currently performing an abort
operation.

ClientAborts (Pgsvr)

Number of times the client gem of this page server aborted a transaction.

ClientCommits (Pgsvr)

Number of times the client gem of this page server committed a transaction.

ClientLostOtsSent (Pgsvr)

The number of Lost OT root signals sent from the stone to the page server's client.

ClientPageReads (Pgsvr)

The number of pages that have been transmitted by a page server to its client. This statistic
is implemented only for cache slots used by a page server.

ClientPageWrites (Pgsvr)

The number of pages that have been transmitted by a client to its page server. This statistic
is implemented only for cache slots used by a page server.

ClientPid (Pgsvr)
The process ID of the client process associated with this AIO page server process.

ClientSigAbortsSent (Pgsvr)

The number of SigAborts sent from the stone to the page server's client.

ClockHandFrameld (Pgsvr)

The shared page cache frame ID that the page server clock hand currently references.
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CodeCacheSizeBytes (Gem)

The total size in bytes of copies of GsNMethods that are in the code generation area and
ready for execution, as of the end of mark/sweep.

CodeGenGcCount (Gem)

The number of times the code generation area has been garbage collected.

CommitCount (Gem)

The number of commits executed by a Gem process (or application linked to a Gem) since
the Gem was most recently started.

CommitQueueAddedToRunQueueCount (Stone)

The number of times sessions from the commit queue were added to the run queue.

CommitQueueAddedToRunQueueSessionCount (Stone)

The number of sessions from the commit queue which were added to the run queue.

CommitQueueSessionNotReadyCount (Stone)

The number of times the stone was ready to assign the commit token to a session in the
commit queue but no session was not ready to receive the token.

CommitQueueSize (Stone)

The number of Gem session processes waiting for the commit token.

CommitQueueThreshold (Stone)

The current setting of the STN_COMMIT_QUEUE_THRESHOLD configuration parameter.
This setting determines how large the commit queue must be before the stone will defer
commit record disposal. A value of -1 indicates this feature is disabled and commit record
disposal will never be deferred.

CommitRecordCount (Stone)

The number of outstanding commit records that are currently being maintained by the
system. A number larger than the STN_SIGNAL_ABORT_CR_BACKLOG configuration
option indicates that there is a process in a transaction that is preventing the Stone from
reclaiming (garbage collecting) the resources associated with those commit records. Large
values are usually accompanied by continuing growth in the size of the repository.

CommitRecordDisposalsDeferredCount (Stone)

The number of times the stone deferred commit record disposal because the number of
sessions in the commit queue exceeded the STN_COMMIT_QUEUE_THRESHOLD
setting.

CommitRecordDisposalState (Stone)

An internal statistic used to analyze the commit record disposal routines.
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CommitRecordPagesWrittenByGem (SPC monitor)
CommitRecordPagesWrittenByStone (SPC monitor)

The number of commit record pages in the cache because of a write done by a Gem or by
the Stone, respectively.

CommitRecordsDisposedCount (Stone)

The total number of commit records disposed by the Stone.

CommitRecordsReadAbortCount (Gem)

The number of commit records read while processing an abort.

CommitRecordsReadCommitBeforeCommitQueueCount

The number of commit records read by the session before it requested the commit token
during a commit operation.

CommitRecordsReadCommitinCommitQueueCount

Number of commit records read by the session after it has requested but not yet received
the commit token.

CommitRecordsReadCommitWithTokenCount (Gem)

The number of commit records read while processing a commit and the Gem has the
commit token.

CommitRetryFailureCount (Gem)

The number of commits that failed after exceeding the retry count.

CommitsSinceLastEpoch (Stone)

Number of commits, excluding reclaim commits by GcGems, since the start of the currently
open epoch.

CommitTokenSession (Stone)

The session ID of the gem holding the commit token. If no gem is holding the commit
token, the value will be zero.

CompressedLogPagesWrittenByGem (SPC monitor)
CompressedLogPagesWrittenByStone (SPC monitor)

The number of compressed log pages in the cache because of a write done by a Gem or by
the Stone, respectively.

ContinueTransactionCount (Gem)

Total number of times the session executed the "System continueTransaction" method.
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CountBaglinteriorPagesWrittenByGem (SPC monitor)
CountBaglinteriorPagesWrittenByStone (SPC monitor)

The number of count bag interior pages in the cache because of a write done by a Gem or
by the Stone, respectively.

CountBaglLeafPagesWrittenByGem (SPC monitor)
CountBaglLeafPagesWrittenByStone (SPC monitor)

The number of count bag leaf pages in the cache because of a write done by a Gem or by
the Stone, respectively.

CountMapLeafPagesWrittenByGem (SPC monitor)
CountMapLeafPagesWrittenByStone (SPC monitor)

These statistics are obsolete; the page kind is no longer used.

CrashedSlotsinRecoveryCount (SPC monitor)

The current number of slots being recovered which were owned by a crashed process.

CrashedSlotsRecoveredCount (SPC monitor)

The total number of slots the shared cache monitor has recovered because a client process
shutdown abnormally.

CrashedSlotThreadTimeRunningMs (SPC monitor)

Approximate real time in milliseconds that the crashed slot recovery thread in the shared
page cache monitor has spent doing work.

CrPagelLocateForDisposeCount (Stone)

Number of times a commit record page was not found in the stone's commit record cache
at commit record disposal time.

DataPageReads (all)

The number of data pages read by the process since it was last started. These page reads
are actual disk reads and not reads from the shared page cache.

DataPagesWrittenByGem (SPC monitor)
DataPagesWrittenByStone (SPC monitor)

The number of data pages in the cache because of a write done by a Gem or by the Stone,
respectively.

DeadDataPagesWrittenByGem (SPC monitor)
DeadDataPagesWrittenByStone (SPC monitor)

The number of dead data pages in the cache because of a write done by a Gem or by the
Stone, respectively. Dead data pages are intended for disposal.

GemTalk Systems 41



VSD 3.2 User’s Guide

42

DeadNotReclaimedKobijs (Stone)

The number of objects that have been determined to be dead (current sessions have
indicated they do not have a reference to these objects) but have not yet been reclaimed.
(Units: 1000s of objects.)

DeadObjsReclaimedCount (Stone)

The total number of dead objects reclaimed since the Stone repository monitor process was
last started. For a system in “steady state” for a particular application, look for a uniform
discovery rate per garbage collection epoch. Increasing the duration of the epoch should
increase this value, but that could also cause larger swings in the amount of free space in
the repository.

DeferCkptCompleteCount (Stone)

The number of pending commit operations for which the checkpoint will allow itself to be
deferred before it completes.

DepMapKeysChanged (Gem)

The total number of objects with DependencyMap changes committed by this session.
DirtyListSize (Gem)

The number of modified committed objects in the temporary object memory dirty list.
DirtyPageSweepCount (Pgsvr)

The number of times the page server has swept the cache for dirty pages or frames to add
to the free list.

EmptyBmLeafPagesWrittenByGem (SPC monitor)

The number of empty bitmap leaf pages in the cache because of a write done by a Gem.

EmptyBmLeafPagesWrittenByStone (SPC monitor)

The number of empty bitmap leaf pages in the cache because of a write done by the Stone.

EnvisendCacheSerialNum

Counter on env 1 send site caches.

EpochForceGc (Stone)

This statistic is 1 when a user has requested that Epoch garbage collection be started
manually, and is otherwise zero.

EpochGcCount (Stone)

The number of times that the Epoch garbage collection process was run by the Admin
GcGem since the Admin GcGem was started. For a system in steady state, look for
uniform periods between runs or a uniform run rate.
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EpochLastDuration (Stone)

The duration of the last completed epoch garbage collection operation in seconds.

EpochNewObijs (Stone)

The number of new objects that were created during the last epoch.

EpochPossibleDeadObijs (Stone)
The number of possible dead objects found by the last Epoch garbage collection.

EpochScannedObjs (Stone)

The number of objects scanned by the last Epoch garbage collection.

ExportedSetSize (Gem)

The number of objects in the ExportSet. The ExportSet is a collection of objects for which
the Gem process has handed out an Oop to GemBuilder or Topaz. Objects in the ExportSet
are prevented from being automatically garbage collected in the Gem’s temporary object
memory. The ExportSet is used to guarantee referential integrity for objects only
referenced by an application, that is, objects that have no references to them within the
Gem.

The application program is responsible for timely removal of objects from the ExportSet.
The contents of the ExportSet can be examined using hidden set methods defined in class
System. In general, the smaller the size of the ExportSet, the better the performance is likely
to be. There are a couple of reasons for this relationship. The ExportSet is one of the root
sets used for garbage collection. The larger the ExportSet, the more likely it is that objects
that would otherwise be considered garbage are being retained. One threshold for
performance is when the size of the export set exceeds 2K objects. When its size is smaller
than 2K objects, the export set is stored as a single disk page. When its size is larger than
2K, the export set occupies more than one page and is likely to cause additional I/O.

ExportedSetSizePinnedinMemory (Gem)

The number of objects in the ExportSet that cannot drop out of temporary object memory
nor be garbage collected by in-memory collection of temporary objects. Will include any
objects represented in ExportedSetSize that are not committed. Can be less than
ExportedSetSize if ((System gemConfigurationAt:GemDropCommittedExportedObjs) ==
true).

ExtentFlushCount (all)

The cumulative number of file flush operations performed on any extent by the process.
Note that extents residing on raw partitions do not require flushing. On UNIX systems, file
flushes are performed by calling the fsync() function. During a checkpoint, each extent is
flushed once, except for the primary extent which is flushed twice. Most extent flushes are
performed by the AIO page servers.

FailedCommitCount (Gem)

The number of attempts to commit that failed due to concurrency conflicts.
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ForcedDisconnects (Stone)

Number of session logouts for which stone forced the disconnect of OOB socket.
FragmentBmPagesWrittenByGem (SPC monitor)
FragmentBmPagesWrittenByStone (SPC monitor)

The number of bitmap fragment pages in the cache because of a write done by a Gem or by
the Stone, respectively.

FrameCount (SPC monitor)

The size of the shared cache in frames.

FramesAddedToFreeList (all)

The number of frames added to the free list since the session (for Gems), shared page cache,
or Stone started.

FramesFromFreeList (all)

The number of times the process acquired a page frame in the shared page cache from the
list of free frames.

FramesFromFindFree (all)

The number of times the process acquired a page frame in the shared page cache by
scanning the cache entries. The process tries to find free frames this way instead of taking
them from the free list when the number free is below the value set by the
GEM_FREE_FRAME_LIMIT configuration option. While scanning for free frames under
those conditions is desirable from a system perspective, it represents additional overhead
for the particular session.

FreeFrameCacheNumFrames (all)

The number of frames present in the free frame cache for the process.

FreeFrameCacheSize (all)

The number of frames that the process will add or remove from the shared free frame list
in a single operation. A value of zero indicates that free frames are not cached and will be
added or removed from the shared free frame list one at a time.

FreeFrameCount (SPC monitor)

The number of unused page frames in the shared page cache. This statistic gives some
indication of the utilization of the cache, but it is not tunable. This statistic is valid (non-
zero) only for the shared page cache monitor process slot.

FreeFrameLimit (all)

When the number of free frames in the shared page cache is less than the FreeFrameLimit,
the Gem scans the cache for a free frame rather than use one from the free frame list, so that
the Stone process can use the remaining free frames.
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FreeOops (Stone)

The number of free OOPs in the free list that have not been allocated to a Gem and
committed.

FreePages (Stone)

The size of the free page pool for the repository. Free space in the repository is calculated
at 16 KB for each page in the free pool.

GarbageCollectionState (Gem)

The state of a garbage collection task in the Admin GecGem or a user performing a garbage
collection operation. Values are defined as follows:

0 - Garbage collection not active

1 - Initialization

2 - Mark-sweep

3 - Compute dead objects

4 - Remove not dead objects

5 - Finalize weak references

6 - Start record dead

7 - Write possible dead objects to tranlog
8 - Finish record dead

9 - Write not dead objects to tranlog
10 - Send not dead objects to stone

GcHighWaterPage (Stone)

The lowest page ID for which the GC reclaim gems will temporarily ignore because a
garbage collection operation is in progress. Pages with IDs less than this value will be
reclaimed normally. Page IDs equal to or greater than this value will not be reclaimed. The
session performing the garbage collection will increase this value as the operation
progresses

GciBytesRcvd (Gem)
Number of bytes received from the RPC GClI client.

GciBytesSent (Gem)
Number of bytes sent to the RPC GCI client.

GciPhysBytesRcvd (Gem)

Number of bytes received from the RPC GCI client before decompression.

GciPhysBytesSent (Gem)
Number of bytes sent to the RPC GCI client after compression.

GciRpcCommandsServiced (Gem)
The number of GCI RPC commands serviced by this Gem.
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GciRpcKeepAlivePacketCount (Gem)

Number of keep-alive packets received from the GCI client on a remote host.

GcLockKind (Stone)
Indicates the state of the garbage collection lock and why it is being held:

0 - Free

1 - MarkForCollection

2 - FindDisconnectedObjects

3 - Pre-MarkGcCandidates (loading candidate objects)
4 - MarkGcCandidates

5 - Epoch GC

6 - Reclaim All

7 - (not used)

8 - Repository Scan (listInstances, listReferences, etc)

GcVoteState (Stone)

GcVoteState tracks the progress of a number of phases within garbage collection. Possible
values are:

* 0-Not voting
* 1- Gems are voting on the possible dead set

* 2 - Vote completed, awaiting start of Possible Dead Write-Set Union Sweep
(PDWSUS).

* 3 -PDWSUS in progress
* 4 - PDWSUS completed

Note that all of these phases must complete before the PossibleDead objects can be
“promoted” to DeadNotReclaimed objects. The Admin GcGem is responsible for
performing the possible dead write set union sweep, and must be running for this to occur.

For details about the voting phase of garbage collection, refer to the System Administration
Guide for your version of GemStone.

GcWsUnionSize (Stone)

The number of objects in the write set union used to finalize possible dead objects. All
objects in the WSU must be scanned to determine if any objects reference one or more
possible dead objects.

GcWsUnionSweepCount (Stone)

The total number of sweeps of the possible dead write set union that have been done by the
Admin GecGem since it started.

GemFreePages (Gem)

The number of free pages that the VM or Gem has acquired but has not yet used.
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GemHasCommitToken (Gem)

A boolean that indicates whether the Gem holds the commit token.

GemsInCacheCount (SPC monitor)

The total number of Gems using the shared page cache whose process slot you are viewing.
This is useful for distinguishing Gems using a local shared page cache from those using a
remote shared page cache.

GemTempObjCacheSizeKb (Gem)
The value of the session's GEM_TEMPOB]_CACHE_SIZE_KB configuration parameter.

GlobalDirtyPageCount (SPC monitor)

The total number of pages in the shared cache that are dirty but not yet eligible for
asynchronous writing to the disk because they have not yet been committed. If this value
is very large, then very large transactions may be filling the cache. Otherwise, if the Stone
repository monitor is running on this cache, the Stone’s private page cache size may be too
small. This statistic is available only for the shared page cache monitor’s slot (currently Slot
0).

GlobalStat00 — GlobalStat47 (Stone)

User-defined statistics that can be written and read by any Gem on any Gem server; that
is, these statistics are stored in the shared page cache of the Stone, rather than that of the
machine on which the Gem is running. There are 48 global cache statistic slots available.

GsMsgCount (Stone)

The number of messages processed by the Stone on behalf of Gems. This statistic can help
determine how busy the Stone is.

GsMsgKind (Stone)

An integer identifying the kind of message the Stone is currently processing.

GsMsgSessionid (Stone)

The session identifier of the Gem for which the Stone is currently processing a message.

IndexProgressCount (Gem)
Used to monitor the status of certain index operations:

0 - Inactive

1 - Identity index audit in progress.

2 - Equality index audit - auditing root terms.

3 - Equality index audit - auditing NSC counts.

4 - Equality index audit - auditing btree counts.

5 - IndexManager>>removeAlllndexes in progress.
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InvalidPagesWrittenByGem (SPC monitor)
InvalidPagesWrittenByStone (SPC monitor)

The number of invalid (i.e. empty) pages in the cache because of a write done by a Gem or
by the Stone, respectively.

LastCommandFromClient (Pgsvr)

The numeric index of the last message sent to the page server by its client.

LastErrorNumber (Gem)

The number of the last error processed by the session. Fatal errors are not reported in this
statistic.

LastSessionFatalError (Stone)

The session ID of the last session that reported a fatal error to the stone.

LastSessionldStopped (Stone)

The session ID of the last session that was sent a stop session message.

LastSessionldTerminated (Stone)

The session ID of the last session that was forcibly logged off by the stone.

LastSessionLostOt (Stone)

The session ID of the last session that was sent a SigLostOtRoot signal.

LastSessionSigAbort (Stone)

The session ID of the last session that was sent a SigAbort.

LastSleepTimeBetweenScans (SPC monitor)

Number of milliseconds the shared page cache monitor statistics thread slept after the last
complete scan of the cache.

LastSleepTimeWithinScan (SPC monitor)

Number of milliseconds the shared page cache monitor statistics thread last slept while in
the loop that computes cache statistics. The thread will sleep for a short interval each time
it scans 100,000 cache frames.

LdiThreadOperations (Stone)

The number of wakeups from semaphore wait in stone NetLdiCall Thread.

LocalCacheAllocatedPceCount (Gem, Stone)

The number of page cache entries that the process has allocated for collision chains.

LocalCacheFreeFrameCount (Gem, Stone)

The number of frames in the private page cache that are free.
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LocalCacheFreePceCount (Gem, Stone)

The number of page cache entries in the free pool.

LocalCacheOverflowCount (Gem, Stone)

The number of times that a page was moved from private cache to the shared cache because
the private cache was full.

LocalCachePceCountLimit (Gem, Stone)

The maximum number of page cache entries that the process will allocate before
performing a reclaim.

LocalCachePceReclaimCount (Gem, Stone)

The number of page cache entry reclaim operations performed by the process.

LocalCacheStalePcesRemovedCount (Gem, Stone)

The number of stale page cache entries that the process has removed from its private page
cache lookup table. Stale PCEs occur when a reference to page in the shared cache becomes
invalid because the page is removed from the cache by another process.

LocalCacheValidPcesRemovedCount (Gem, Stone)

The number of valid page cache entries removed by a reclaim operation.

LocalDirtyPageCount (SPC monitor)

The total number of pages in the shared cache that are dirty and eligible for asynchronous
writing to the disk. The Stone’s AIO page server will write these pages to the disk. This
statistic is available only for the shared page cache monitor’s slot (currently Slot 0).

LocalPageCacheHits (all)

The number of times a page lookup found the page in the shared page cache. No I/O was
required to access the page.

LocalPageCacheMisses (all)

The number of times a page was not found in the shared cache and a read operation was
required to get the page.

LockReqQueueSize (Stone)

The number of Gem session processes waiting for a commit to complete so that their lock
request can be serviced.

LockWaitQueueSize1 — LockWaitQueueSize10 (Stone)

The number of sessions waiting for the Application object lock with the given number.
(System waitForApplicationWriteLock:queue:autoRelease:)

LogHighQueueAdds (Stone)
Number of additions to the LogHighQueue. See LogHighQueueSize.
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LogHighQueueSize (Stone)

The number of sessions waiting for transaction log writing to be not saturated. This queue
holds mostly committing sessions

LoginLogFlushes (Stone)

Number of times the stone's login log thread has flushed writes to the login log file.

LoginLogThreadOperations (Stone)

Number of operations performed by the stone's login log thread

LoginQueueSize (Stone)

The number of sessions waiting for login completion.

LoginRequestsCount (Stone)

The total number of login requests processed since the Stone started.

LogLowQueueAdds (Stone)

Number of additions to the LogLowQueue. See LogLowQueueSize.

LogLowQueueSize (Stone)

The number of lower priority sessions waiting for transaction log writing to be not
saturated. This queue holds primarily sessions logging resourcelds such as possibleDead
or notDead.

LogRecordPagesWrittenByGem (SPC monitor)
LogRecordPagesWrittenByStone (SPC monitor)

The number of transaction log record pages in the cache because of a write done by a Gem
or by the Stone, respectively.

LogRecordsloCount (Stone)

The number of physical write operations performed on the transaction logs since the Stone
repository monitor process was last started. The minimum write to a transaction log is 512
bytes (one log record). The maximum number of bytes written in a single I/O to the
transaction log is 64K. The implication for performance tuning is that to achieve the best
throughput (in transactions per second) you would like to have as few as possible writes
to the transaction logs. The technique for achieving this is to tune the size of the
transactions so that each transaction writes one or more completely filled 64K records.

LogRecordsWritten (Stone)

The number of log records that have been written to the transaction logs since the Stone
repository monitor process was last started. The size of a log record is 512 bytes.
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LogWaitQueueSize (Stone)

The size of the queue that holds sessions waiting for space to become available in a
transaction log. This queue should be empty or nearly so unless the space for logging
transactions has been exhausted.

LookupCacheSerialNum

Counter on per-class method lookup caches.

LostOtDeferCount (Stone)

The total number of times Stone has deferred sending a LostOtRoot signal to a session.

LostOtPagesWrittenByGem (SPC monitor)
LostOtPagesWrittenByStone (SPC monitor)

The number of lost OT pages in the cache because of a write done by a Gem or by the Stone,
respectively.

LostOtsReceived (Gem)

The number of Lost OT Root signals received and recognized by this session.

LostOtsSent (Gem)

The number of Lost OT Root signals the Stone has sent to this session, although the session
may be in a sleep or I/O wait state and not yet aware of having received the signal. (See
LostOtsReceived (Gem), above.)

MainThreadTimeRunningMs (SPC monitor)

Approximate real time in milliseconds that the main shared page cache monitor thread has
spent doing work.

MarkSweepCount (Gem)

The number of mark/sweeps executed by the in-memory garbage collector.

MaxUserSessions (Stone)

The maximum number of user sessions stone is configured for.

MaxVotingSessions (Stone)

Maximum number of sessions that can concurrently vote on possible dead objects at the
end of an MFC (markForCollection) or Epoch garbage collection.

MeSpaceAllocatedBytes (Gem)

The number of bytes allocated for remSet, in-memory oopMap, and map entries.

MeSpaceUsedBytes (Gem)

The number of bytes occupied by remSet, in-memory oopMap, and in-use map entries.
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MessageKindToStone (Gem)

The message type of the most recent message sent to the Stone.

MessagesToStnProcessingCommit (Gem)

The number of messages sent to the Stone while the gem is processing its part of the
commit.

MessagesToStnStoneCommit (Gem)

The number of messages sent to the Stone while the Stone is processing its part of the
commit.

MessagesToStnWaitingForCommit (Gem)

The number of messages sent to the Stone while waiting for the commit token.

MessagesToStone (Gem)

The number of messages sent by the Gem session process to the Stone repository monitor
using shared memory as the channel.

MethodsRead (Gem)
The number of GsNMethods copied into VM memory since the start of this session.
MilliSecPerloSample (all)

MilliSecPerloSample is used as a parameter to implement the configurable I/O limit for
GemStone processes. Because a process’s I/O rate currently is sampled every five I/O
operations, this statistic is computed as 1000/ (ioLimit * 5). A value of 1 means that the
process has no I/O limit. If the time in milliseconds since the last sample equals or exceeds
MilliSecPerloSample, the process can perform another I/O operation; if not, the process
sleeps. MilliSecPerloSample is particularly useful in limiting I/O rate of a process that is
executing a long-running operation. If you want to calculate the current I/O limit, it is
given by 1000/ (MilliSecPerloSample * 5).

MiClearAllICount (Gem)

Number of times that all send-site caches were cleared.

MiFullLookupCount (Gem)
Number of times that fullMethodLookup was called.

MiLuCacheGrowCount (Gem)

Number of times that a per-class lookup cache was grown to larger table size.

MiLuCachelLargeCount (Gem)

Number of times that a per-class lookup cache became a large object.

MiLuCacheResetCount (Gem)

Number of times that a per-class lookup cache was reset.
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MIPolyCacheCreateCount (Gem)

Number of times that a polymorphic send-site cache was created.

MIPolyCacheFullCount (Gem)

Number of times that a polymorphic send-site cache overflowed.

MIPolyCacheGrowCount (Gem)

Number of times that a polymorphic send-site cache was grown.

MtActiveThreads (Gem)

The number of threads actively working on a multi-threaded task in a Gem executable.

MtMaxThreads (Gem)

The maximum number of threads currently configured for a multi-threaded task in a Gem
executable. Set by the method that initiated the operation.

MtPercentCpuActiveLimit (Gem)

Can be set by a session to control the maximum number of active threads working on the
task. Value must be between 0 and 100. When a non-zero value is set, the controller thread
attempts to keep the percentCpuActive stat below this value by limiting the number of
threads working on the task.

MtThreadsLimit (Gem)

Can be set by a session to control the maximum number of active threads working on the
task. Must be less than or equal to MtMaxThreads.

MultObjPagesWrittenByGem (SPC monitor)
MultObjPagesWrittenByStone (SPC monitor)

The number of multiple object pages in the cache because of a write done by a Gem or by
the Stone, respectively.

NetWriteThreadSocketWrites (Stone)

The number of socket write operations attempted in stone NetWrite thread.

NetWriteThreadWakeups (Stone)

The number of wakeups from semaphore wait in stone NetWrite thread.

NewGenSizeBytes (Gem)

The number of used bytes in the new generation at the end of mark/sweep.

NewObjsCommitted (Gem)

The number of new objects committed by the most recent transaction committed by this
process.
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NewObjsCommittedNotLogged (Gem)

Number of newly created objects that were committed but not added to the tranlog
because they are reachable from the NotTranloggedGlobals root object.

NewSymbolRequests (Gem)

The number of symbol creation requests by a session to the symbol creation Gem.

NewSymbolsCount (Gem)

The number of new symbols created by this session.

NextSleepTime (Pgsvr)

The number of milliseconds that the page server will sleep during the next sleep period.
This value is adjusted to regulate the IO rate of the page server.

NotifyQueueSize (Stone)

The number of Gem session processes using notifiers.

NumCacheWarmers (Stone)

The number of cache warmer gem processes currently operating on the shared cache.

NumEphemerons (Gem)

The number of live ephemerons remaining at the end of the last mark/sweep garbage
collection.

NuminLdiQueue (Stone)

The number of uncompleted requests in the stone NetLdiCall thread input list.

NuminLoginLogQueue (Stone)

Number of sessions queued to have entries written to the stone's login log file.

NuminMaininpQueue (Stone)

The number of requests from other threads in the stone main thread input list.

NuminNetReadWorkList (Stone)

The number of tasks in the NetRead thread work list, produced by NetPoll action functions
and not yet processed by the NetRead thread.

NuminNetWriteQueue (Stone)

The number of uncompleted requests in the input list to the stone NetWrite thread.

NumLiveSoftRefs (Gem)

The number of instances of SoftReference in temporary object memory found during an
attempt to clear SoftReferences. This counter remains at zero until temporary object space
grows to at least GEM_SOFTREF_CLEANUP_PERCENT_MEM.
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NumNonNilSoftRefs (Gem)

The number of instances of SoftReference in temporary object memory with non-nil, non-
special values, that were found during an attempt to clear SoftReferences. This counter
remains at zero until temporary object space grows to at least
GEM_SOFTREF_CLEANUP_PERCENT_MEM.

NumProcsSleepingForLock (SPC monitor)

Number of processes on this shared page cache that are currently sleeping while waiting
to acquire a spin lock.

NumRefsStubbedMarkSweep (Gem)

The number of references contained in copies of committed objects that were stubbed
(converted to a Pom objectld) by in-memory mark/sweep.

NumRefsStubbedScavenge (Gem)

The number of in-memory references that were stubbed (converted to a Pom objectld) by
in-memory scavenge.

NumSharedCounters (SPC monitor)

The number of shared counters for this shared cache.

NumSoftRefsCleared (Gem)

The number of times that the in-memory garbage collector has cleared the value instance
variable in instances of SoftReference.

NumVotingSessions (Stone)
The number of sessions that the stone has requested to vote on possible dead objects.
ObjectMemoryGrowCount (Gem)

On AIX and HPUX only, the number of times object memory was grown or shrunk by
allocating a new virtual memory region with mmap().

ObjectsRead (Gem)

The number of committed objects copied into VM memory since the start of this session.

ObjectsReadInBytes (Gem)

Total size in bytes of committed objects copied into VM memory since start of session.

ObjectsRefreshed (Gem)

The number of committed objects in VM memory that have been re-read from the page
cache after transaction boundaries, since the start of this session.

ObjectTablePageReads (all)

The number of object table pages read by the process since it was last started. These page
reads are actual disk reads and not reads from the shared page cache.

GemTalk Systems 55



VSD 3.2 User’s Guide

56

ObjsCommitted (Gem)

The number of objects committed by the most recent transaction committed by this
process.

ObjsCommittedNotLogged (Gem)

The total number of objects (new and modified objects) reachable from the
NotTranloggedGlobals root object which the session has committed.

OldestCrSession (Stone)

The session ID of a session referencing the oldest commit record. Note that more than one
session may reference a commit record. A value of -1 indicates that the oldest commit
record is not referenced by any session.

OldestCrSessNotInTrans (Stone)

The session ID of a session that is not in a transaction that is currently referencing the oldest
commit record, which may be preventing it from being reclaimed.

OldGenSizeBytes (Gem)

The number of used bytes in the old generation at the end of mark/sweep.

OmBytesFlushed (Gem)

The total number of temporary object memory bytes flushed to Pom during commit
attempts for this session.

OopNumberHighWaterMark (Stone)

The highest number of object identifiers allocated by the system.

OopsReturnedByGemsCount (Stone)

The total number of free oops returned to the stone by any gem.

OtherPageReads (all)

The number of pages read by the process that were not object table, data, or bitmap pages
since the process was started. These page reads are actual disk reads and not reads from
the shared page cache.

OtinternalPagesWrittenByGem (SPC monitor)
OtinternalPagesWrittenByStone (SPC monitor)

The number of object table internal pages in the cache because of a write done by a Gem or
by the Stone, respectively.

OtLeafPagesWrittenByGem (SPC monitor)
OtLeafPagesWrittenByStone (SPC monitor)

The number of object table leaf pages in the cache because of a write done by a Gem or by
the Stone, respectively.
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PageDisposesDeferred (Stone)

The number of times a page disposal had to be deferred. This deferral can be caused by an
asynchronous operation (checkpoint) being in progress on the page or by the page being
attached or locked.

PageloCount (all)

The number of page I/O (page read or page write) calls done by the process since it was
last started. Each I/O call may read or write more than one page.

PageloTimeOverallAvg (all)

The average duration of a page I/O (page read or page write) call in microseconds.

PageloTime10SampleAvg (all)

The average duration of a page I/O (page read or page write) call in microseconds. The
average is computed for the last ten I/O operations, and is updated every ten I/O
operations.

PageloTime100SampleAvg (all)

The average duration of an1/O call (page read or page write) in microseconds. The average
is computed for the last 100 I/ O operations, and is updated every ten I/O operations.

PageLocateCount (all)

The number of times that the process located a page. The page may have been read from
disk or found in the cache.

PageManagerMaxWaitTimeMs (Stone)
Current value of the STN_PAGE_MGR_MAX_WAIT_TIME configuration option.

PageManagerStarvedCount (Stone)

Number of times the page manager session waited for service from the stone longer than
STN_PAGE_MGR_MAX_WAIT_TIME milliseconds.

PageMgrCompressionEnabled (Stone)

A boolean value: true if the page manager session is compressing the list of pages that it
sends to remote cache page servers, false otherwise.

PageMgrPageRemovalRetryCount (Stone)

Number of times the page manager session has retried removing one or more pages from
the shared page caches because the first attempt to remove the pages failed.

PageMgrPagesNotRemovedFromCachesCount (Stone)

The total number of pages that the Page Manager was unable to remove from one or more
shared page caches.
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PageMgrPagesPendingRemovalRetryCount (Stone)

The current number of pages that could not be removed from shared page caches by the
page manager on the first attempt and are waiting to be retried.

PageMgrPagesReceivedFromStoneCount (Stone)

The total number of pages that the Page Manager session received from the Stone to
remove from shared page caches.

PageMgrPagesRemovedFromCachesCount (Stone)

The total number of pages that the Page Manager has successfully removed from all shared
page caches.

PageMgrPolls (Stone)

The number of times the pagemanager thread has polled.

PageMgrPrintTimeoutThreshold (Stone)

The time threshold in seconds used by the page manager to decide if a message should be
printed to its log file indicating that a remote cache page server was slow to respond.

PageMgrRemoteCachePgsvrTimeout (Stone)

Number of seconds the page manager session will wait to receive a response from a remote
cache page server.

PageMgrRemoveFromCachesCount (Stone)

The total number of times that the Page Manager has attempted to remove pages from
shared page caches.

PageMgrRemoveFromCachesPageCount (Stone)

The total number of pages that the Page Manager has attempted to remove from shared
page caches. This statistic includes pages processed by page removal retry operations,
which occur whenever a page cannot be removed from a shared page cache on the first
attempt.

PageMgrRemoveMaxPages (Stone)

The maximum number of pages the Stone will return to the page manager session in a
single batch.

PageMgrRemoveMinPages (Stone)

The minimum batch size of pages that the page manager will process. The page manager
will request pages to process from the Stone only if the Stone cache statistic
PagesWaitingForRemovallnStoneCount exceeds this value.

PageMgrRemovePagesFromCachesPollCount (Stone)

The number of times that the Page Manager called poll() or select() to determine which
cache page servers have completed removing pages from their shared caches. This statistic
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represents the value during the most recent page disposal operation and is not cumulative.
It varies between zero (when there are no remote shared caches on the system) and the
number of remote shared page caches.

PageMgrSleepMs (Stone)

The number of milliseconds the pagemanager thread has slept.

PageMgrSleepState (Stone)

The number of times pagemanager thread has slept.

PageMgrThreadWakeups (Stone)

The number of times pagemanager thread has woken up.

PageMgrTimeWaitingForCachePgsvrs (Stone)

The total amount of real time in milliseconds that the page manager has spent waiting to
receive data from remote cache page servers.

PageReads (all)

The number of pages read by the process since it was last started. These page reads are
actual disk reads and not reads from the shared page cache.

PageReadsProcessingCommit (Gem)

The number of pages read while the Gem is processing its part of the commit.

PageReadsStoneCommit (Gem)

The number of pages read while the Stone is processing its part of the commit.

PageReadsWaitingForCommit (Gem)

The number of pages read while waiting for the commit token.

PageServersinCacheCount (SPC monitor)

The total number of page servers attached to the shared cache.

PagesNeedReclaimSize (Stone)

The amount of reclaim work that is pending, that is, the backlog waiting for the Reclaim
GcGem to reclaim.

PagesNotFoundinCacheCount (SPC monitor)

The number of pages needing to be removed from the cache that were not found in the
cache. This statistic is updated by the cache page server on remote caches, or by the page
manager on the Stone’s shared page cache.
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PagesNotRemovedFromCacheCount (Pgsvr)

The number of pages the page server was unable to remove from the cache. Requests to
remove pages come from the stone. This statistic is updated by the cache page server on
remote caches, or by the page manager on the Stone’s shared page cache.

PagesRemovedDirtyFromCacheCount (SPC monitor)

The number of pages successfully removed from the cache by the cache page server or the
Page Manager at the Stone’s request. This statistic is updated by the cache page server on
remote caches, or by the page manager on the Stone’s shared page cache.

PagesRemovedFromCacheCount (SPC monitor)

The total number of pages successfully removed from the cache by the cache page server
or the Page Manager at the stone's request.

PagesReturnedByGemsCount (Stone)

The total number of free pages returned to the Stone by any Gem.

PagesWaitingForRemovalDeferred (Stone)

Number of deferred persistent pages waiting to be processed by the Page Manager gem.

PagesWaitingForRemovallnStoneCount (Stone)

The number of pages in the Stone that are waiting to be removed from the shared page
cache by the Page Manager.

PagesWaitingForRemovalPersist (Stone)

Number of persistent pages waiting to be processed by the Page Manager gem.

PagesWaitingForRemovalTemp (Stone)

Number of temporary pages waiting to be processed by the Page Manager gem.

PageWaitQueueSize (Stone)

The size of the queue that holds sessions waiting to be allocated free pages. This queue
should be empty or nearly so unless the repository is below its free space threshold.

PageWrites (all)

The number of pages written by the process since it was last started. These page writes are
actual disk writes and not just writes into the shared page cache. Unless a large data load
is in process, the number should be low for all processes except the Stone’s AIO page server
process.

PermGenSizeBytes (Gem)

The number of used bytes in the perm generation at the end of mark/sweep. Perm
generation holds copies of Classes.
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PersistentPagesCommittedCount (Gem)

The total number of pages made persistent (committed) by the session. This statistic is
updated during commit processing.

PersistentPagesDisposed (Stone)

The number of persistent pages (pages already checkpointed) that have been disposed of
while in the Stone’s private cache.

PgsvrCheckpointState (Pgsvr)

The state of checkpoint processing within an AIO pgsvr:
0=not active
1=writing dirty pages
2=finished write dirty
3=in fsync
PgsvrWaitQueueSize (Stone)

The number of remote sessions waiting on page server before reclaiming session resources.

PinnedDataPagesCount (SPC monitor)

The number of pinned data pages found in the cache.

PinnedOtPagesCount (SPC monitor)

The number of pinned object table pages found in the cache.

PinnedPagesCount (all)

The number of pages the process has pinned (locked) in the shared cache. Pages may be
pinned by more than one process at the same time.

PinnedPrivatePagesCount (all)

The number of pages that the process has pinned (locked) in its private page cache.

PinnedSharedCount (SPC monitor)

The number of pages pinned by more than one process.

PinnedTotalCount (SPC monitor)

The total number of pinned pages found in the cache.

PomGenScavCount (Gem)

The number of times scavenge has thrown away the oldest pom generation space.

PomGenSizeBytes (Gem)

The number of used bytes in the pom generation at the end of mark/sweep. Pom
generation holds clean copies of committed objects.
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PossibleDeadObjs (Stone)

The number of objects previously marked as dereferenced in the repository, but for which
sessions currently in a transaction might have created a reference in their object space. An
object is not declared (“promoted to”) dead until each active session verifies the absence of
such references during its next commit or abort.

PossibleDeadSymbols (Stone)

The number of symbols found to be not referenced in a markForCollection.

PostCheckpointPages (Pgsvr)
The count of pages written out by the page server during post-checkpoint processing.

PreemptedBitmapPages (Pgsvr)

The number of bitmap pages removed from the shared page cache by this page server.

PreemptedCommitRecordPages (Pgsvr)

The number of commit record pages removed from the shared page cache by this page
server.

PreemptedDataPages (Pgsvr)

The number of data pages removed from the shared page cache by this page server.

PreemptedObjectTablePages (Pgsvr)

The number of object table pages removed from the shared page cache by this page server.

PreemptedOtherPages (Pgsvr)

The number of pages removed from the shared cache by this page server that were not
data, object table, commit record, or bitmap pages.

PrimitiveNumber (Gem)

The primitive number currently being executed by the session, or 0 if the session is not in
a primitive. The session only sets this value for long-running primitives. A non-zero value
also indicates the session is immune from termination due to the STN_GEM_TIMEOUT
mechanism.

Note: the PrimitiveNumber stat is set to 9999 if the session has executed System class >>
disableStoneGemTimeout

ProcessesWaitingForQueueLocks (SPC monitor)

Number of processes attached to the shared cache that are spinning while attempting to
acquire a queue lock.

Processlid (all)

The operating system processld for the process associated with this shared page cache
process slot.
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ProcessName (all)

This statistic identifies the process kind (Gem, Stone, page server, or shared page cache
monitor).

ProgressCount (Gem)

You can use this statistic to monitor the progress of certain Repository methods that may
run for extended periods.

* During objectAudit, ProgressCount is set to the number of live data pages at end
of the object table scan, then decremented as data pages are scanned.

* During _findPagesContainingOops:, ProgressCount is set to the total number of
pages in the repository and decremented as pages are processed.

* During markForCollection, ProgressCount is incremented as live objects are
marked during the marking phase, reset to zero, and incremented as possible dead
objects are computed.

* During epoch garbage collection, ProgressCount is incremented as live objects
within epoch are marked, then reset to zero.

* During fullBackupTo: and restoreFromBackup:, ProgressCount tracks the number
of objects written to or restored from the backup file(s).

* During objectAudit, ProgressCount is incremented as the object table is scanned,
then decremented as data pages are scanned.

* While reading and writing an FDC file of OOPs, ProgressCount is incremented as
OQPs are read or written.

RcConflictCount (Gem)

The number of commits that resulted in an RC conflict.

RcRetryQueueSize (Stone)

The number of sessions waiting for the RcRetry object lock. (System waitForRcWriteLock:)

ReadLocksSize (Gem)

The number of objects that are read locked.

RebuildScavPagesForCommitCount (Gem)

The total number of times the gem rebuilt its list of scavengeable pages while processing a
commit.

RecentActiveProcessCount (SPC monitor)

The number of active processes attached to the shared page cache. This statistic is
computed more often than ActiveProcessCount and has decays quickly.

ReclaimCount (Stone)

The number of reclaims performed by a Reclaim GeGem process since the Stone repository
monitor was last started.
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ReclaimedPagesCount (Stone)

The number of pages reclaimed by a Reclaim GcGem process since the Stone repository
monitor process was last started. The count indicates the number of pages that have been
or will soon be placed back into the repository’s pool of free pages.

ReclaimedSymbols (Stone)

The number of symbols that have been reclaimed since the stone was started.

RecoverFreeFrameWaitTime (Stone)

The time in seconds spent by the main recovery thread waiting for free frames in the shared
page cache. Recovery performance may be improved by increasing the size of the shared
page cache.

RecoverNumBufs (Stone)
The total number of logEntryBuffers allocated in the heap.

RecoverNumBufsForSessions (Stone)

The number of logEntryBuffers used to hold records for sessions not yet committed.

RecoverNumBufsinFreeList (Stone)

The number of logEntryBuffers currently in the freeList.

RecoverNumBufsinWorkQueue (Stone)

The number of logEntryBuffers currently in the workQueue.

RecoverReadThreadWaitTime (Stone)

The time in seconds that the reader thread spent waiting for the main recovery thread to
catch up processing the log buffers.

RecoverReclaimOopsWaitTime (Stone)

The time in seconds spent by the main recovery thread waiting for oops to be reclaimed.
Recovery performance may be improved by adding more reclaim gems.

RecoverTranlogBlockld (Stone)

The block ID of the transaction log currently being replayed during system recovery or
restore.

RecoverTranlogFileld (Stone)

The file ID of the transaction log currently being replayed during system recovery or
restore.

RejectedProcsCount (SPC monitor)

The total number of processes which attempted to connect to the shared page cache but
were rejected because the maximum number of processes had already attached.
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RemoteCachesNeedServiceCount (Stone)

The number of remote caches that require service from the Page Manager. Caches need
service when they are starting or shutting down.

RemoteSharedPageCacheCount (Stone)

The total number of remote shared page caches attached to the system.

RemoteSharedPageCacheMax (Stone)
Current setting of the STN_MAX_REMOTE_CACHES configuration parameter

RepBkupRestPagesWrittenByGem (SPC monitor)
RepBkupRestPagesWrittenByStone (SPC monitor)

These statistics are obsolete; the page kind is no longer used.

ReposSizeMB (Stone)

The size of the stone's repository in MB.

Root40PagesWrittenByGem (SPC monitor)
Root40PagesWrittenByStone (SPC monitor)

The number of root 4.0 pages in the cache because of a write done by a Gem or by the Stone,
respectively.

RootPagesWrittenByGem (SPC monitor)
RootPagesWrittenByStone (SPC monitor)

The number of root pages in the cache because of a write done by a Gem or by the Stone,
respectively.

RunQueueSize (Stone)

The number of Gem session processes waiting for service from the Stone repository
monitor.

ScavengeCount (Gem)

The number of scavenges executed by the in-memory garbage collector.

ScavengeOverflows (Gem)

The number of scavenges that overflowed in the in-memory garbage collector.

Sessionld (all)

The GemStone sessionld associated with this client.

SessionPerformingBackup (Stone)

The session ID of the session that is performing a full backup; 0 if a full backup is not in
progress.
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SessionStat00 — SessionStat47 (Gem)

These are computed by user code to define statistics associated with a session. There are 48
session cache statistic slots available.

SessionWithGcLock (Stone)

The sessionld of the session holding the GcLock. A value of 1 indicates that the lock is held
by Stone recovery or restore; 0 means that the lock is not issued.

ShadowedPagesCount (Gem)

The number of data pages added to the reclaim list due to commits by this Gem. This
statistic is only updated during a commit.

SigAbortsReceived (Gem)

The number of times the Stone has signaled this session to abort, that it has received and
recognized.

SigAbortsSent (Gem)

The number of times the Stone has signaled this session to abort, although the session may
be in a sleep or I/ O wait state and not yet aware of having received the signal. (See
SigAbortsReceived (Gem), above.)

SleepDuringDisposeTempPageCount (Gem)

Total number of times the Gem slept while waiting to dispose of a temporary page. Each
tick of the counter represents 5 milliseconds of sleep. If you encounter excessive counts,
please report them to GemStone Technical Support.

SlotsCrashedCount (SPC monitor)

The total number of slots for which the shared cache monitor has attempted recovery
because a client process shutdown abnormally.

SlotsFreeCount (SPC monitor)

The number of free process slots currently available in the cache.

SlotsTotalCount (SPC monitor)

The maximum number of processes that can concurrently attach to the shared page cache.

SpinLockCount (SPC monitor)
The current setting of the SHR_SPIN_LOCK_COUNT parameter.

SpinLockFreeFrameSleepCount (SPC monitor)

The number of times the process was forced to sleep on a semaphore while attempting to
acquire the free frame list spin lock. Available only for shared page cache monitor slot.
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SpinLockFreePceSleepCount (SPC monitor)

The number of times the process was forced to sleep on a semaphore while attempting to
acquire the free page cache entry spin lock. Available only for shared page cache monitor
slot.

SpinLockHashTableSleepCount (SPC monitor)

The number of times the process was forced to sleep on a semaphore while attempting to
acquire a hash table spin lock. Available only for shared page cache monitor slot.

SpinLockNewSymSleepCount (SPC monitor)

The number of times a process was forced to sleep on a semaphore waiting for the
NewSymbols spinLock.

SpinLockOtherSleepCount (SPC monitor)

The number of times the process was forced to sleep on a semaphore while attempting to
acquire either the AllSymbols or shared counter spin lock. Available only for shared page
cache monitor slot.

SpinLockPageFrameSleepCount (SPC monitor)

The number of times the process was forced to sleep on a semaphore while attempting to
acquire a page frame spin lock. Available only for shared page cache monitor slot.

StatsThreadTimeRunningMs (SPC monitor)

Approximate real time in milliseconds that the statistics thread in the shared page cache
monitor has spent doing work.

StnAioCompletionFailures (Stone)

The number of aio_write() operations for which either aio_error() or aio_return() reported
that the AIO failed.

StnAioFsyncFailures (Stone)

The number of fsync() operations in AioWait thread which failed.

StnAioMainTimelnAioWrite (Stone)

Total real time in milliseconds that the main thread spent executing the aio_write() call.
aio_write() is used to initiate asynchronous writes to the tranlog and should not block.

StnAioNumWriteThreads (Stone)

Value of the STN_NUM_AIO_WRITE_THREADS Stone configuration parameter, which
determines how many threads are dedicating to writing to the tranlog.

StnAioWaitsForWork (Stone)

The number of times the Stone’s AIO wait thread waited on semaphore for more work.
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StnAioWaitTotalTime (Stone)

Approximate total real time in milliseconds that the AIO wait thread spent waiting for
asynchronous I/O requests to complete.

StnAioWriteFailures (Stone)

The number of aio_write() calls by the Stone main thread which failed with other than
EAGAIN. Stat should normally be zero.

StnAioWriteQueueHighWaterSize (Stone)

High water mark of the StnAioWriteQueueSize statistic.

StnAioWriteQueueSize (Stone)

Size of the tranlog write request queue.

StnAioWritesQueuedCount (Stone)

Total number of tranlog write requests that have been queued.

StnAioWriteThreadsldle (Stone)

Number of tranlog write threads in the Stone process that are currently idle.

StnCrBacklogThreshold (Stone)
Current setting of the STN_CR_BACKLOG_THRESHOLD Stone configuration parameter.

StnGetLocksCount (Stone)

The total number of times the Stone retrieved the lock set and passed it to a remote gem.

StnLoopCount (Stone)

The total number of times the Stone has executed its service loop. If this number remains
unchanged for a significant period (for example, ten seconds or so), the Stone has hung,.

StnLoopHibernateCount (Stone)

The total number of times the Stone went to sleep waiting for a network event to occur. This
state occurs when StnLoopState is set to 17.

StnLoopNoWorkThreshold (Stone)

Current setting of the STN_LOOP_NO_WORK_THRESHOLD stone configuration
parameter.

StnLoopsNoWork (Stone)

Number of times the stone has executed its main service loop and found no work to
perform. This counter is reset to zero each time the stone performs work.
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StnLoopsSinceSleep (Stone)

Number of times the stone has executed its main service loop since sleeping. This counter
is reset to zero each time the stone sleeps while waiting for work.

StnLoopState (Stone)

An integer that identifies where, in the Stone control loop, the Stone process is currently
executing. For a meaningful statistic, set your sample rate to faster than a second. For state
definitions, consult GemStone technical support.

StnMainWaitsForFreeAio (Stone)

The number of times the stone main thread waited for free AIO buffers to become
available.

StnTranQToRunQThreshold (Stone)

Current setting of the STN_TRAN_Q_TO_RUN_Q_THRESHOLD stone configuration
parameter.

StoneCommitState (Stone)

This internal statistic is used to determine the state of the Stone’s commit processing.

SymbolCreationQueueSize (Stone)

The number of sessions waiting for a Symbol creation request to be processed.

TargetFreeFrameCount (SPC monitor)

The minimum number of unused page frames the free frame page server(s) will attempt to
keep in the cache. The free frame count can still fall below this value if the cache contains
mostly dirty pages, which free frame page servers cannot preempt.

TargetPercentDirty (Pgsvr)

The percent of dirty pages that AIO page servers try to maintain in the shared cache. If the
dirty pages are below this target then the I/O rate will be limited on the next scan. If the
dirty pages are above this target then the I/O rate will be set to AioRateMax.

TempObjSpacePercentUsed (Gem)

The approximate percentage of the total reserved temporary object memory for this session
which is in use. Sessions are likely to encounter an out of memory error if this value
approaches or exceeds 100%. This statistic is only updated at the end of a mark/sweep
operation.

TempPagesDisposed (Stone)

The number of temporary pages (pages allocated since the last checkpoint) that have been
disposed.
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TimelnCommitRecordDisposal (Stone)

The total amount of real time in milliseconds that the Stone has spent disposing commit
records. Commit records disposed during repository startup are not included in this
statistic.

TimelnFramesFromFindFree (all)

The cumulative number of milliseconds that the Gem or Stone has spent scanning the
shared page cache for a free frame since the session (for Gems) or Stone started.

TimelnGetPagesForPageMgr (Stone)

Real time in milliseconds spent by the stone processing requests from the page manager
session for lists of pages to remove from shared page caches.

TimelnMarkSweep (Gem)

The real time in milliseconds spent in in-memory garbage collector mark/sweeps.

TimelnPgsvrNetReads (Stone, Gem)

The cumulative amount of real time in milliseconds that a session or Stone has spent
reading network data from a page server.

TimelnPgsvrNetWrites (Stone, Gem)

The cumulative amount of real time in milliseconds that a session or Stone has spent
writing network data to a page server.

TimelnProcessPagesFromPageMgr (Stone)

Real time in milliseconds spent by the stone processing the list of pages from the page
manager session which were removed from shared page caches.

TimelnScavenges (Gem)

The real time in milliseconds spent in in-memory garbage collector scavenges.

TimelnStnGetLocks (Stone)

The total time spent by the Stone retrieving the lock set and passing it to a remote gem.

TimelnStonePageDisposal (Stone)

The elapsed real time in milliseconds the Stone spent performing page disposal operations.

TimelnUpdateUnionsCommit (Gem)

The total real time the gem spent updating its unions while waiting for the commit token.

TimelnWaitsForOtherReaders

The real number of milliseconds the process spent waiting for the read of another process
to complete.

GemTalk Systems April 2014



VSD 3.2 User’s Guide

April 2014

TimeLastEpochGc (Stone)

Time at which the Admin GecGem finished computing dead objects for the last epoch. Time
to end of the currently open epoch is computed from here.

TimePerformingCommit (Stone)

The number of milliseconds of real time the Stone has spent performing commit
processing, not including time taken by asynchronous writes to the transaction log.

TimePerformingReadlo (Pgsvr)

The total amount of real time in milliseconds the page server has spent reading pages from
disk.

TimePerformingReadRequests (Pgsvr)

The total amount of real time in milliseconds the page server has spent performing read
requests for its client. This statistic includes time reading pages from disk and time
searching the shared page cache for pages.

TimeProcessingCommit (Gem)

The cumulative amount of time in milliseconds that the Gem session process has spent
doing the processing for commits while it has the commit token.

TimerThreadWakeups (Stone)

The number of wakeups from sleep in stone Timer thread.
TimeSleepingMs (Pgsvr)

Total real time the process has spent sleeping, in milliseconds.

TimeStoneCommit (Gem)

The cumulative amount of time in milliseconds that the Gem session process has waited
for the Stone repository monitor to complete commits by this session.

TimeWaitingForCommit (Gem)

The cumulative amount of time in milliseconds that the Gem session process has spent
waiting for its turn to commit, that is, the time waiting for the commit token and the Stone’s
processing time for serialization.

TimeWaitingForlo (all)

The total real time in milliseconds that the process has spent waiting for I/ O calls that read
or write pages to complete. Only page /O is included in this statistic. Other types of I/O
(such as transaction log writes by the Stone process) are not included.

TimeWaitingForStone (Gem)

The total time the Gem spent waiting for a response from the Stone.
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TimeWaitingForSymbols (Gem)

Cumulative elapsed time in milliseconds waiting for symbol creation requests to be
processed.

TotalAborts (Stone)

The number of abort operations performed system-wide since the Stone was started.

TotalBmPageReads (SPC Monitor)

Total number of bitmap pages read by all processes currently attached to the shared page
cache.

TotalCommits (Stone)

The total number of commits (excluding read-only commits) performed by all processes
since the Stone repository monitor was last started.

TotalDataPageReads (SPC Monitor)

Total number of data pages read by all processes currently attached to the shared page
cache.

TotalFramesAddedToFreeList (SPC Monitor)

Total number of frames added to the free list by all processes currently attached to the
shared page cache.

TotalFramesFromFindFree (SPC Monitor)

Total number of frames found by scanning the cache for all processes currently attached to
the shared page cache.

TotalFramesFromFreeList (SPC Monitor)

Total number of frames taken from the free list by all processes currently attached to the
shared page cache.

TotalGemFatalErrors (Stone)

The total number of fatal errors reported to the stone by all gems.

TotalLocalPageCacheHits (SPC Monitor)

Total number of local page cache hits for all processes currently attached to the shared page
cache.

TotalLocalPageCacheMisses (SPC Monitor)

Total number of local page cache misses for all processes currently attached to the shared
page cache.

TotalLostOtsSent (Stone)

The total number of SigLostOtRoot signals sent by the stone.

GemTalk Systems April 2014



VSD 3.2 User’s Guide

April 2014

TotalMiscPageReads (SPC Monitor)

Total number of miscellaneous pages read by all processes currently attached to the shared
page cache.

TotalNewObjsCommitted (Stone)

The total number of new objects committed by all Gems.

TotalOtPageReads (SPC Monitor)

Total number of object table pages read by all processes currently attached to the shared
page cache.

TotalPageReads (SPC Monitor)

Total number of pages read by all processes currently attached to the shared page cache.

TotalPageWrites (SPC Monitor)

Total number of pages written by all processes currently attached to the shared page cache.

TotalPcesAddedToFreeList (SPC Monitor)

Total number of PCEs (Page Cache Entries) added to the free list by all processes currently
attached to the shared page cache.

TotalPcesIinFreePceCaches (SPC Monitor)

Total number of free PCEs (Page Cache Entries) present in the free PCE caches of all
processes currently attached to the shared page cache.

TotalPcesRemovedFromFreeList (SPC Monitor)

Total number of PCEs (Page Cache Entries) removed from the free list by all processes
currently attached to the shared page cache.

TotalProcsinCacheCount (SPC monitor)

he total number of processes currently connected to the cache, including crashed processes
that have not yet had their cache slot recovered.

TotalSessionsCount (Stone)

The total number of sessions currently logged in to the system.

TotalSessionsStopped (Stone)

The total number of stop session requests initiated by a gem or by the stone.

TotalSessionsTerminated (Stone)

The total number of sessions forcibly logged off by stone.

TotalSigAbortsSent (Stone)
The total number of SigAborts sent by the stone.
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TotalWaitsForOtherReader (SPC Monitor)

Total number of PageRead operations avoided by all processes currently attached to the
shared page cache.

TotEphemeronsFired (Gem)

Total number of ephemerons whose key has been garbage collected. Only updated at the
end of a mark/sweep GC.

TrackedSetSize (Gem)
The number of objects in the Tracked Objects Set, as defined by the GCI.

TranlogFileld (Stone)

The file id of the transaction log to which the most recent tranlog entry was written.

TranlogKBytesWritten (Gem)

Total number of KB written to the tranlog by stone on behalf of this session.

TranlogRecordld (Stone)

The record id of the most recent transaction log entry to be written.

TranlogRecordKind (Gem)

The kind of tranlog record last written to the tranlog by stone on behalf of this session.

TranlogRecordsWritten (Gem)

Total number of physical tranlog records written to the tranlog by stone by this session.

TranlogsFull (Stone)

A flag indicating if all configured tranlog partitions or directories are full; 1 means full.

TransactionLevel (Gem)

This statistic describes the state of the Gem: 1 (in a transaction), 0 (outside a transaction), or
-1 (a transactionless state in which the Stone will never signal the Gem to abort).

TteCrPageFreeCount (Stone)

Total number of free commit record page entries in the stone's internal commit record
cache.

TteCrPageFreePoolSize (Stone)

Total number of commit record page entries allocated in the stone's internal commit record
cache.

TteFreeCount (Stone)

Total number of free TTEs (transaction table entries) in stone.
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TteFreePoolSize (Stone)

Total number of TTEs (transaction table entries) allocated by stone.

UpdateUnionsCommitCount (Gem)

The total number of times the gem updated its unions while waiting for the commit token.
This count will be at least one for every commit.

VoteNotDead (Gem)

The number of objects that the Gem process removed from the possible dead set the last
time that it voted on the possible dead.

VoteNotDeadObijs (Stone)

The number of objects that the Gem process removed from the possibleDead set the last
time that it voted on the possible dead.

WaitingForSessionToVote (Stone)

The sessionld of a session which the system is waiting for to complete the voting on
possible dead objects. A zero value indicates that it is not waiting.

WaitsForOtherReader (all)

The number of PageRead operations avoided by waiting for read already in progress by
another process.

WorkingSetSize (Gem)

The number of objects in memory that have an object Id assigned to them. Approximately
the number of committed objects that have been faulted in plus the number that have been
created.

WriteLocksSize (Gem)

The number of objects that are write locked.
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